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= EGL and the Workbench terms and concepts
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What is RDi-SOA ?

= RDi-SOA stands for Rational Developer for System i for SOA Construction

= |IBM® RDi-SOA is a new software bundle that was made available in the first
quarter of 2008. It combines IBM® Rational® Developer for System i and IBM®

Rational® Business Developer.

= This combination offers a complete solution for modern Web development and use
of Web services to rapidly extend existing RPG and COBOL applications to a Web
or service-oriented architecture (SOA) environment.

» |BM Rational Business Developer

provides an Eclipse integrated
development environment (IDE)
for EGL. (EGL is a modern
language designed to shield
i5/0OS application programmers

from the technical complexities of

Web and SOA middleware and
standards.)
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Contral Business Enterprise Connection
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What is SOA ?

SOA is defined by IBM's SOA foundation as follows:

"Service-Oriented Architecture (SOA) is an architectural style for creating an
enterprise IT architecture that exploits the principles of service-orientation
to achieve a tighter relationship between the business and the information
systems that support the business.”

SOA has the following characteristics:
» It enhances the relationship between enterprise architecture and the business.
» It allows the building of composite applications as a set of integrated services.
» It provides flexible business processes.

Service-Oriented Architecture implies new roles in the enterprise, new ways
of collaborating, new supporting frameworks and new types of software
artifacts in an evolutionary (as opposed to a "revolutionary") way.
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Definitions of a SOA

What is service
orientation?

Away of infegraling your
business as li
services
and the outcomes that

they bring

What is a service?

A repeatable

What is a service?
business task = e

» A service is a repeatable logical | eheckeustomercredi
manifestation of a business task.

» A service is about a part of a
business process -- not about

software or IT. What s sevics oreried

What is a mmp-narta

application?
An IT architectural A set of related &
style that supports integrated services that
service orientation support a business

process built on an SOA

What is Service Orientation?

» Service orientation is a way of integrating a business as a group of linked
services.

» Service orientation is not about technology; It is about a new way of looking at
business and how it operates.

What is SOA?
» SOA is an architectural style that supports the service orientation.
» SOA is an enterprise-scale IT architecture for linking resources on demand.

- IBM, Software Group
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What is SOA About ?

“‘SOA is about flexible business processes. It supports the flex-pon-sive*
company by merging technology, business insight, and thought leadership
fo create an environment in which innovation can thrive.”

The top 10 don'ts for your flex-pon-sive* journey are:

Don't expect maximum business without SOA.

Don't just do technology; it's a transformation of the way you do business.
Don't throw everything out.

Don't bite off big projects all at once.

Don't forget to set expectations.

Don't expect to do this without a culture modification through governance.
Don't forget the right skills.

Don't expect flexibility without open standards.

Don't do this alone - leverage partners with experience.

Don't do it without a strong plan because the first step is the most important.

vV VvV VvV VvV VvV VvV VvV VvV v VY

- Sandy Carter, Vice President of SOA and WebSphere Strategy, IBM Corporation
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What makes EGL powerful?

EGL supports a variety of SOA-related capabilities that help business-
oriented developers become extremely productive in a short time.

Abstra@
Declarative
S04

Generation ( Languege

N

——
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RDi-SOA and EGL

RDi-SOA and EGL provides several ways for developers to increase their productivity
for i5/0OS application development:

= Abstraction. EGL provides concise and powerful notations that help to eliminate the tight coupling. It
reduces the amount of coding required to interface systems and middleware. This abstraction simplifies and
speeds up development work.

= Declarative programming. EGL includes a certain level of declarative specifications to help reduce
repetitive and error-prone coding. For example, validation rules associated with a data item trigger
validation to be run whenever the item is used in a Web page or a 5250 screen.

= Language. EGL is a comprehensive but easy-to-learn language. It is modern, modular, and readable. It has
a rich library of built-in functions to boost your productivity for commonly required operations, such as date
and time math, string manipulation, and so forth. In addition, the language is extensible and offers full
interoperability with other languages, including EGL interfaces to native Java, as well as seamless
invocation of RPG or COBOL programs or any ILE procedures.

= Generation. Though simplified, the EGL development technology must still guarantee optimal deployment
to the runtime platforms to take advantage of their Qualities of Service (QoS) and to allow native
management and monitoring of the systems in operation. This is accomplished through a code generation
engine available as part of the Rational Business Developer Extension that transforms the EGL
specification into native Java or COBOL source, and creates any other required deployment artifacts.

= Tools. RDi-SOA contains a rich set of Eclipse-based capabilities, including EGL source-level debugging,
powerful smart editing, visual construction, graphical navigation, and automated generation of
Create/Read/Update/Delete (CRUD) applications from Unified Modeling Language (UML) models or from
data schemas.

= SOA. EGL is designed to facilitate services development and deployment. A simplified SOA development
paradigm is built into the language itself and complemented with the tools. You can create services without
the need to know Web service protocols and standards, such as Web Services Description Language
(WSDL), Simple Object Access Protocol (SOAP), or Extensible Markup Language (XML).

- Linda Cole, Manager of IBM Rational Business Ecosystem
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The Value of RDi-SOA and EGL

Organizations that need to deliver modern, powerful Web and SOA solutions

can enjoy the following benefits:

» Increased programmer productivity
» 300% to 1000+ percent

Reduced training costs

» Easy to learn
Reduced errors and deliver higher quality

» Generates Java, JavaScript and Web Services
Simplified legacy integration

» Call RPG programs

» Encapsulate RPG programs into Web Services

A newly empower class of developers delivering modern solutions and SOA

Increased flexibility and responsiveness by eliminating skills silos
» EGL developer can be RPG + Java + SOA + JSF/RUI developers

* Reduced development and maintenance costs via a flexible choice of

deployment options, including:
» All major IBM Operating Systems and runtimes
» Cross platform solutions
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SOA and Web 2.0 Rich Ul

= Web 2.0 Rich Ul makes extensive use of services, and
SOA - Service Oriented Architecture, which is a way to
modularize and deploy code so that it can be consumed
anywhere in the world using any language.

= There are two types of Web Service calls used by Web 2.0
Rich Ul

1. RESTful service calls — A call made through the HTTP service-interface.
Once the call is made, a result is passed back to the requestor in XML or JSON
format.

2. SOAP service calls - A type of service call that is more popular in enterprise.
It requires the exchange of XML messages between the client and host system.

Rich UI

Server-Side EGL
Enterprise Server-Side
Computing vesOF ... Application

\ bk~ bac A
ASSeELts Resources

Application

= By utilizing web services you build modular, scalable systems.
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SOA Challenge

= SOA helps create greater
alignment between IT and line
of business while generating
more flexibility

= According to a survey of six
hundred senior executives
around the world, the #1 barrier
that companies are seeing to
adopting SOA is shortage of

skills.

The Layers Of A SOA
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= Successful SOA adoption is done incrementally stressing the importance
of starting small, and scaling appropriately.

= Legacy applications are frequently at the core of your IT environment.
But many times, these essential applications are isolated and

iInaccessible to common skill sets. Without the right skills and tools, it

can be difficult to integrate these core investments with the rest of your

IT environment.
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What Are Your Skills ?

= IBM i Skills

dRPG ILE
dRPG/Free
JEmbedded SQL
dSynon/2E

JRDi

= Web Development Skills

dJava Server Faces
dJava

dJavaScript

dAJAX

dSOA, WSDL, SOAP
dREST, XML

© 2009 IBM Corporation
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What is EGL?

EGL is Enterprise Generation Language

High-level programming language for developing
leading-edge business applications

Independent of implementation
» Hides technology complexities
» Presentation and persistence layer API fully generated

Enables Rapid Application Development
Simplifies development of Services (SOA)

Run-time code generated for appropriate platform
» Java for Windows, Linux, System i, and so forth
» COBOL for System z and System i

Development and Generating Tools included with RBD

Migration path for CSP, Visual Age Generator, and
Informix 4GL customers

Integrates with leading-edge software technologies
» Eclipse, JSF, Application Servers, etc.

Run COBOL

Develop EGL Generate

Run Java

Genherate

z/0S
1Series

WebSphere Application Server
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Three Main Benefits of the EGL Language

= Java, SOA, COBOL, System Z/I/P, Browser, ...
= Optimal native generation to any platform
= Easy inter-operability with legacy

= High productivity with equal flexibility

» Language simplicity and robustness

* Immediately useable by business developers
= Scalable software architectures

= Effectively hide technical complexity
ABSTRACT = Use declarative approach to everything
= Support emerging standards
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EGL Portability - RBD/EGL Platform Coverage

Windows, Linux,
EGL

Business Logic

= WebSphere
Common Reposnory - Other J2EE
System z iy m— Application Servers
a e ep— = Native i50S
® Vebophers «dava ¢ e s Native 1508
= USS N
= Linux copoL I x System i
s Batch 3 I oo oo S a1 e optns
. clcs s e COBO = WebSphere
= Other J2EE
= IMS

Application Servers
Browser = Native i50S

= Native i50S
—> . |E*

JavaScript _
Web 2.0

Firefox *
= Safari*

@
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Portability - RBD/EGL Technology Support
CIEED CIZTD CHEED CTHED

We
E—

M = ﬁ_- = 2 AN _.,é" J;-'Q
5 | ==l | =3 'Y

» DB2 UDB
» SQL Server
» Oracle
* Informix
Z . » DL/1
Business Logic . VSAM

» others...

Access to Legacy System Resources

System i

System z
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RBD/EGL - Higher Level Abstractions

= Extend the natural evolution of
programming language as an
abstraction of business
expression

EGL

VB

>  SIMPLE

COBOL/RPG

PhP/Ruby

“Re-training COBOL developers to Java/J2EE costs over
$50K each, and only 12% may actually succeed” — Gartner
Group

c o

“The task force had an initial meeting and identified Assembler

challenges to teaching Java, based on the literature and our
experiences.” — ACM Education Board Java Task Force

COMPLEX -

Machine Language

An insurance company spent approximately $250,000 to
train 12 RPG developers. One out of 12 succeeded. This
person had a MS in Computer Science and 8 years of C
programming experience. — Bob Cancilla
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EGL and the Model-View-Controller Framework

» The model-view-controller framework (referred to as MVC or "model 2") has

many benefits and is often considered a best practice for developing Web
applications.

» Use EGL to develop applications that are divided into these three functional
layers:

L
AL L ilmeavine || = -
1L i s - ,': : e -
EGL Libraries b = -
EGL Programs g =

4 & .

= PATAT : ™

| Call EaL EGL e
i Programs...

[ PageHandler HTML.

Library functions... Files
e
P Y 4 ISP
3 Call EGL Pages
A = =1 = v =
Database
—_— "

Model Controller View
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What is Rational Business Developer (RBD)?

= One of several products
that allows you to do
develop using the EGL

language. Other products

include:
» RDI-SOA
» RDz

= Member of the Rational
Software Development
Platform (SDP)

= Support for wide range
of platform, middleware,
and technologies

= Rich Eclipse-based
tooling

- Project Explorer &3 =8 allcustomers, jsp | B allcustomers.egl &3
= <}_j¢} i Epac!kat_:[e jafhandlers;

= 7= EGLWeb
+-'z@ Deployment Descriptor: EGLWeb
Tl 'web Site Mavigation
= [E- EGLSource
+ f_u com.ibm.eql. jsf
=[] jsfhandlers
L@ allcustomers.eql
| B updatecustomer.egl
Sal Ealweb.eqlbld
5 EqLweb.egldd
i3 Java Resources
%@y, web Diagram {I-D #sqly

+-By Javascript Suppaork select
. . i CUSTOMEER ID, FIRST MNAM
Uy Security Editar — —

o wWebContent EMAIL ADDRESS, STREET,
' POSTALCODE, DIRECTICNS

handler allcustomers type J3FHandler
{onConstructionFunction = onConstructi
onPrerenderFunction = onPrerender,
view = fglloustomers.jsp™}

customer customerTemp[0] :
A/ Function Declarations

function onConstructioni)
get customer with

+

+-[= cam
il images from EGL.Customer
*-5= META-INF order hy
-2 theme state asc
+-5= WEB-INF a P

allcustomers. jsp en

- . function onPrerender()

i updatecustomet . jsp a

en

t-l=F Servers
end

record customerTemwp twype 3QLRecord
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What is the RBD Workbench?

File Edit Display Toolbar Insert 1SP Faormat Table Frame Page Tools Mavigate Search Project Run Window  Help
if-HE (g i i%-0-Q- G- 6 i @IF BEE IR PG

'r[\jProjact Explorer &2 = 0|= *allcustomers.jsp £5 |_—|%|allcustomers.egl

8 ¢ (Ko o)

= O || B snippets | &% Palette 52

The RBD
Workbench is

ﬁ | @ myPerspective

c

| =) <='?> || sleustomers.jsp - A_gray * @ hxicolumnEx * Standard * @ HTML Tags
the software that == & meres
‘21 Deployment Descriptar: EGLWeb @EGL
e n abl eS yo u to = ‘% ;\I'Gibsjlut::gawgatmn - | @ Enhanced Faces Components
[ com.ibm.egl.jst [[E] Data Table
Crea?e 3 test, = i thandlers = Data Tree
~L B allcust el :
m Od Ifys run and (& zpcdu:t::zz;::r‘egl & A List of Customers . [E7] Panel - Group Box
deploy your EG L % Eztme:eg:z: " Panel - Form Box
eh.eg
1 H 228 Java R - - n - - [ Panel - Section
appllcatlons : %; \p::I?DingUr:i:es CUStomer—ldub: || Ful Nameub: Phoneub:: Cltyub: [E&l Panel - Dialog
=, Javascript Support ["]Fanels - Tabhed
i ﬁg Security Editor i
=52 WebContent [=3 Button - Command
. = B
It org anizes and = o DISTATEN |#{CUSTOMER_005D], | ILAST_00SMAME] ., IFIRST_D0SMAMED | IPHONED | [CITY 4 th dal
. . 2 META-INF Linl
i theme TE] Menu B
malntaInS yOUI’ B WEBIF I TOOlS
ft B allust j Action Bar
i allcustomers. jsp i
S O Wa re E updatecustomer . jsp E) % - Farm Item
development 1 ervers e

resources

Edit and design area

Input - Text Area
Input - Rich Text Area
[ Input - Password

[¥] Check Box
It provides Fommcon
access to tools = Comboin

like editors,

Organizer

Design | Source | Split | Preview

List Biox - Single Select
[EH List: Box - Multiple Select

. Fl o = =
deslg n tOOIS £E QUi @ pegelata: = l—.g_\ Problems | 4L servers | = Properties 52 & quick Edit| B Consle B~ =08 ESelect - Color
’ S = 5] Select - Calendar
CO m pi Ie rS and 2 Scripting Varisbles kr 1d: | columnEx1 | Size: Width: l:l Alignment: Horizontal: & Flle Upload
- — ile: Uploa
= (= 15F Handler td ) .
folde rS for = Data tpl:put style: Props: l:l Height: I:I(D'XEIS) ertical: 2 OUEpUE
(= Actions hexe:seriptCallectar [[Joo nat line wrap cell contents - 4
1 Classes: l:l CE = . . |:| {n} Oukput - Formatted Text
I I Ian ag I ng yo u r E% TR hx:dataTableEx - Background: Calor: C] [ mags
(2 Services 1| <defaul -
a | ICatI O n ’S 2 RPC Adapter Services (I hov:columnEse = = Image e Chart .
p p accessibilicy =% Page Template
Styles

contents
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How do | develop with the RBD Workbench?

= You will work with a variety of resources: EGL code, Web pages, Graphic images,
Data files. The Workbench allows most of the resources associated with a project to be
stored in a workspace — which is the highest-level folder that contains everything you

can access during a development session.

» Your Workbench session begins with the opening of a Workspace. Everything you

have access to is inside this Workspace.

» Workspace resources are organized into
- Projeci(s)
- Folders
- Files

Workspace <

-

Folders -<

Files —

r. Froject Explorer X

[~

-

[ §

|

k=3

- 5

25 Depl] ment Descriptor: EGLWeb
{L-. Security Editor
&y, web Diagram
B web Site Mavigation
[,-;I;:- EGLSource
|I| eqlderbeyr 7
|I| eqlderbyr 7, access
|I| eqlderbyr?.data
|I| eqlderbyr 7. primitivetypes. data
|I| jsfhandlers
de| EGLWweh.eglbld
:5 Java Resources: src
== wWebContent
[= META-INF
[= theme
[ tilesCantent
(= WEB-INF
allcustomers. jsp
kest.jsp
updatecustamer . jsp
I%g] eqglderbeyr 7. kpm
|X| eqglderbyr? uml
|=| jet.appdef
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What is in a Project?

= Workspace projects organize and manage related
application resources. They can be designed along lines of:

» Batch — or — Online applications

» Different business applications (Accounts Payable, Inventory,
Claims, Part Assembly, etc.)

» Common (shared) projects consisting of data and record
definitions that can be reused

= Projects also contain configuration data, such as build
files** and generation options for EGL Java and/or COBOL
generation

» Projects may be further divided into folders

= EGL “Web” projects contain the following high-level folders:
\EGLSource\
\Java Resources:
\WebContent\

src\

- See slide NOTES and the Help topic: Contents of an EGL
Application

EGL
Source
Files

Java
Source
Files

Web
Pages
and
Web App
Resource
Folders

[ Wweb =ite Mavigaton
=-¢
ﬂ] eqglderksy 7
ﬂj eglderbyr 7, access
ﬂ] eqglderbwr 7 .data
|I| eqglderbyr 7. primitivebypes, datz
= ﬂ] jsFhandlers
|_—|%| allcustomers, egl
|__|%| kest.eql
|_—|%| updatecustomer . eql
%8| EGLWeb,eglbid
= :—9‘ Java Resources: sro
B eglderbyr?
EE eglderbyr 7, access
B eqglderbyr7.data
=i jsfhandlers
_m allcustomers. java
allcustomersBeanInfo.java
_m kest.java
kestBeanInfo.java
_m updatecustomer.java
updatecustomerBeanInfo.j
8 jsfhandiers theme
8 jsfhandlers tilescontent
=i, Libraries
== WebConkent
= META-IMF
= theme
[= tilesConkent
(= WEB-INF
allcustomers. jsp
test.jsp
updatecustomet . jsp

= El -
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What is in \EGLSource\

\EGLSource\ is the default folder that is the highest level Fin Froject Explorer X 08~
folder under which all of your EGL resources are organized. = i EcLiveb
‘=8 Deployrment Descriptar: EGLWeh
. f Security Editor
= These EGL resources include EGL: %, web Disgran
B web Site Mavigation
4 PaCkageS = [E- EGL3ource :
: ﬂj eqglderbeyr 7
» Files i eglderb:r?.access
= Programs |_I_| eglderbyr?.data
= Libraries %?sgf:f:l:zr;rrz.prlmltwet';.-'pes.data
n Services |__|%| allcustomers.eg
|__|%| kest,eql [%
" JSFHandIerS Dﬁupdatecustumer.egl
= EGL build-files ) EGLieb egbld

= Typically you will create sub-folders under \EGLSource\ {0
manage your EGL resources

= \We will define what is in all these EGL resources a bit later in
this course

= For now, it is enough to know that all EGL files end with the
extension: .egl

- See the Help topic: EGL Projects, Packages and Files
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What is in Java Resources: src

\src\ is the default highest level folder that contains all of the generated Java,

for each and every successfully compiled (or in EGL terms, “generated”) EGL
resource

;You\will rarely if ever need to actually open or even view the contents of
SrcC

= But the folder structure of \sre\ will match \EGLSource\ one-for-one

= Your generated java files will end with a .Java extension

%8| EGlweb, eqlbld
— L » 7™ JlavaResources: src
B eqlderbyr?
B eglderbyr? . access
£ eqlderbeyr? . data
M jsthandlers
0
m allcustomersBean]
!T_I test,java
m kestBeanInfo.java
!T_] updatecustomer, java

m updatecustomerBeanInfo.java
+-Bi Libraries

F

1]~ -EH- B

allcustomers, java

0.java

R [ oy O O Y
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What is in \WebContent\

\WebContent\ is the default highest-level folder under
which all of your web resources will be organized,
including:

» Application Server reserved folders:
= META-INF
= WEB-INF

» Web Pages (*.jsp) and web page resources:
\theme\ - Graphics (*.gif, *.jpg)
\theme\ - Template pages (*.htpl)
\theme\ - Cascading Style Sheets (*.css)

# Note that your installed EGLWeb project might have a
few additional folders and files — such as an \images\
directory, that we’'ve supplied, containing graphics files you'll
use throughout the course

? And if you're not familiar with the above types of web files
don’t worry. We'll be covering them later on in the course

Content

B Project Explorer X

5= EGLWweb

‘B8 Deployment Descriptor: EGLWeh
ﬁg Security Edikar
o, Web Ciagram
B 'web Site Mavigation
@ EGLSource
f;? Jawa Resources; src
[=-[== WebContent
== META-INF
[ MAMNIFEST.MF
[= theme
=-[= WEEB-INF
= classes
= lib
X| Faces-config,xml
X| ibrn-web-bnd, xmi
X| ibrn-web-ext, xmi
@ web.xml

kest.jsp

updatecustomer . jsp
%] eglderbyr? . kpm
X| eglderbyr? uml

\=| jet.appdef
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Terms and Concepts — .EAR File — Simplified J2EE Deployment — for WAS Users

ployment
escriptor

e
De

EGLWeb
WAR file
(Modules)

other
.WAR files

Utility Java Classes

.JAR files

5 EGLWeb
=R = EGLWebEAR

EI I|E| Deployment Descripkor: EGLYWebEAR.
- B0 Modules
-0 Utility JARS
= = META-INF
#- (= ibmconfig
- I% application.xml

» An EAR (Enterprise ARchive) file contains a

J2EE application, which is a collection of J2EE
modules. The modules contain Java generated
from EGL. Because individual J2EE modules are
contained within the EAR, they can easily be
managed and deployed as a whole to
WebSphere.

An EAR also has a Deployment Descriptor file
which describes how it should be deployed to
WebSphere. In addition, each module within the
EAR has its own Deployment Descriptor.

An EAR file is similar to an iSeries “savefile for
I” — or to a System z “load library” — which are
files deployed on mainframes that also contain
individual “modules”

© 2009 IBM Corporation
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» Launch RBD

» From the Windows start menu, launch RBD ...or...RAD with RBD (depending on
what product you have installed on your PC)

» At the Workspace Launcher window, specify the directory into which you want to
organize all of your RBD Education resources.

W Usually something like: ¢: \RBDv7\ ...or... d: \RBDv7\

W Close the Welcome window

This opens to the RBD Workbengh (next slide)

Welcome X
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» Configure Preferences — 1 of 3

&~ You need to configure a few preferences,

in order to complete the labs in this course.

= From the RBD Workbench menu

» Pull down the Window menu, and
select Preferences...

» Expand the EGL folder and
from within the EGL folder...

= (Click Page Designer

= Check M all three options
as shown in the screen capture

= Click APPLY

= Expand the Server Preferences
From Launching — check to see that:

M Automatically restart servers when necessary Launcing I

is on by default

Click Apply

Do not leave Preferences yet

& Preferences

| type fileer text Page Designer =l
General L ) )
Active Correlation Ten JSFHandler Options {when language is EGL)
Agent Controller JsFHandler package | jsfhandlers |
Analysis
At Loadbundle variable | labels |
Backward Compatibilit
Connectiity When a Weh Page is deleted, also delete its associated J5FHandler file
Data 8 :
= EaL :When a JsFHandler file is deleted, also delete its associated Web page
Bidi Preferences iw'hen a J5FHandler File is deleted, also remove any generated artifacts
Debug | E
Defaylf [%

ditar
eneration

Page Designer
Service

0L
SO & preferences

=13

Text F
bype Filker ket Launching
Backward Carpabibiit g . Automatically publish when starting servers

Connectivity

Data Automatically restart servers when necessary
EGL
#-EMFT JET Ti fForme
Help renstorma Save dirky editors before starting server
Install{Update O tlways O'Never (&) Prompt
Inkernet

J3EE When switching to a different server mode
Java ORestart OContinue @Prompt

Jython

Model Yalidation ‘When switching the server out of debug mode

Modeling (O Restart () Disable breakpoints () Continue  (5) Prompt
Package Marming Prefi

Plug-in Development

Repart Design ) Always OMever  (5) Prompt

RunjDebug

————F P Server
Audia

Installzd Runkime

‘When switching the server into debug mode, re-enable breakpoints

‘“WebSphere
Spell Check.
SOL Development
Team
Walidation
e and XML
‘Web Services
Web Tools

[

( RDoclet m [Restore Defaults | [ apply |
(':)j I oK H Cancel ]
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» Configure
Preferences — 2 of 3

= Still from within the

Preferences Window:

= From General

» Startup and Shutdown:

» Uncheck all of the
options shown here
in the screen capture

>

= Click Apply

£ Preferences

itype filker bext

> =

E-&#

I R R R R R R |

General
Appearance
Capabilities
Compare/Patch
Content Types
Editors
Errar Reparking
keys

Metwork Connections

Perspectives
Search
Security

Web Browser
Workspace
Agent Conkroller
Aank
Backward Campatibiliky
Data Managenenk
Ecare Diagram
EGL
Help
InstallfUpdate
Java
Java EE
Javascript
JET Transformations
JPA

Startup and Shutdown

|

Startup and Shutdown

Prompk For workspace on skartup
[ ]Refresh workspace on startup

Confirm exit when closing last window

Plug-ins activated on startup:

- BX

PreferenceHarvester Plug-in

[] 10M3 common licensing LT

[] 1005 ITLM Enablement

Extensions Plug-in

Debug Daermon

|:| Java annokakions

IEM Common Migration UI

EJE Deployment Core UI

Links DE UI Support

[] 1B8M D232 Tools UL

Code Coverage IDE LI

Support Plug-in

[] 1BM Rational Merge Clearcaseversioncheck
1EM Rational Compare and Merge Server

1EM Rational Modeling Platfarm Skartup Plugin
[] Equinox Provisioning Platform Update Support
WTP Webservice I Plug-in

JavaServer Faces Tools - Core

Aukamatic Updates Scheduler

service policy

[Restu:ure Defaults ] [ apply M

l

H Cancel ]
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»| Configure &*
Preferences — 3 of 3

Still from within the
Preferences Window

» From Validation
» Click Disable All
» Click Apply

= |f prompted, do a full
rebuild

© 2009 IBM Corporation

£ Preferences

[ty fiter text

=
&
&

a8
a
a
a
a
a
a
a
a

a8
a
a
a
a
a

sk
a
a
a

General
Agent Controller
Ank

Backward Compatibility

Daka Management
Ecare Diagram

EGL

Help

InstallfUpdate

Java

Java EE

Javascripk

JET TransFormations
JPA

Jython

Model Yalidation
Modeling

Flug-in Developrment
Report Design
FunfDebug

Server

Service Policies
Team

Yalidation
Web

Web Services
rDoclet

ML

Yalidation

Allow projects ko override these preference settings

[ suspend all validators

[ ]5ave all modified resources automatically prior to validating

Shows a confirmation dialog when performing manual walidations

The selected validators will run when walidation is performed:

Walidakor

Application Client Yalidator
Classpath Dependency Walidator

Connecktor Yalidator
DTD Yalidator

EAR Walidator

EJE validator

HTML Svnkax Yalidakor

12EE Classpath Yalidakor
Javascripk Synkax Walidation
JDEC Connection File Yalidator
JDBC Metadata File Yalidator

P4 Yalidator

15F application Configuration Yalidator
15F Wiew Extended Yalidator

15F Wiew Walidator
15P Conkent Yalidator
15P Synkax Yalidator
Map Yalidator
ModuleCore Yalidator

Palicy Set 7.0 Binding Configuration Yalidakor
Skatic Web and Publishing Servers Configur. ..

W'ar Y alidakor

biehSnhere FIR 3 N Nenlnwrent Necrrinkar

Enable all Dis%le all

]

Manual = Build = Settings A'
[l B '
] ]

] O =

] ]

] ]

0 O

] ]

] ]

] ]

] O =

0 0 o

o o o

O 0O =

O O

] ]

] O =

] ]

O O |
[Resture Defaults] [ Apply

[ (04 H Cancel ]




PP Workspace Preferences — Customizing the Workbench

The Preferences dialo? (under the
Windows menu) allows you to
customize your workspace
development environment.

P From the main Preferences
dialog you should check:

M EGL with BIRT report support

M EGL support with JSF
Component Interfaces

Other preferences you can
customize:

= Editor

» You can change the editor’s
appearance

= Page Designer

» Specify whether to delete
associated files

= SQL Database Connections

» Specify a connection to an
external database (DB2, IDS,
etc.) for SQLRetrieve

= Click Apply

) Preferences

"t\,f.pe filker text

Perspectives
Search
[#- Security
Startup and Shutdown
Web Browser
[+ Workspace
[+ Agent Controller
[ Ank
Backward Compatibility
[+ Diaka Managemnent
[+ Ecare Diagram
[=-EGL
Bidirectional Text
[+ Debug
Diefault Build Descriptor
[+)- Editor
Gzeneration
Page Designer
[#-Rich LI
Service
56l
50L Database Connecti
[ Help
[ Install{Update
[#- Java
[+ Java EE
[#- JavaScript
[ JET Transformations
IPé
Jython
[+ Modeling
r v im Pomnialameaank

¢ >

- [Ex]
EGL G- -

EGL Base

[ wisualage Generator compatibiity

Creating .eghld Files

The following encoding will apply when creating .eglbld files:

Encoding: | 150 10646/Unicode(UTF-8) ¥
TAMA: UTF-

Diefault EGL Praject Features Chaices
Create an EGL service deployment descriptor

D AL with Jasper repart support
(L with low-level MG APT suppart
[ L with LDAP support

EGL with 15/05 ahiects support

Default EGL Web Project Facet Choices

EGL support with 157

EGL suppart with 15F Companent Interfaces
(AL support with Legacy Web Transactions

Code migration's default weh runtime

<Nongs v

lRestoreQefauItsH Apply ]

I oK, H Cancel ]
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PP Workspace Preferences — Customizing the Workbench — Modify SQL Preferences

The SQL Preferences &1 Preferences |'_|@

allow you to P _ .
H |bwpe Filter text | SOL - -
customize how the B :
H Perspectives -~
RB D t00| | ng Search EGL bype ko use For columns containing an S0L characker data tvpe
generates SQL [+ Security — () Use EGL bype string
Starkup and Shutdown e .
resources b e (O llse Pl bvne limited-lepath string
[+ Workspace —» | ®useEGL type char
[+ Agent Conktroller T =& EGL bvpe mbohar
[+ A0k :
Use EGL bvpe Unicode
}}l Eackward Compatibilityw O i
From the SQL [#]- Data Managerenkt
. 3 # EGL Eype to use Far columns containing an 3L national character data type
Preferences dialo - Ecore Diagram P to s for e 2en=a | characterdata e
=
check: 9 = EGL (¥ Use EGL type dbChar
) Eiiu:lli:ecti-:unal Text ") Use EGL bvpe Unicode
[+ Debug ]
Default Build Descriptor 0 Use EGL type string
® Change to lower case & Editor () Use EGL type limited-length string
H H H aeneration
and capitalize first letter . : .
Page Designer Case conkrol rules For naming structure ikems
after underscore & Rich UL
et ) Do nok change case
SaL () Change tao lower case
® Remove underscores S0l Database Connecti (#) Change to lower case and capitalize First letter after underscors
[+ Help >
[+ InstallfUpdate Underscore contral rules For naming skruckure itemns
[+ Java _
- Jawa EE { ) Do nok change underscores
[#- Jawascript — Iy | @ Remove underscores:
[#- JET Transformations
JFA [] add level pumbers ko record definition
= i:lt;":';_-' Retrieve primary kew information From the system cakalog
[+ Modeling
- Plug-in Developrment Prompk for SOL user ID and password when needed
[+ Report Design “
2 2 [Restu:ure Defaults ] [ Apply ]
) l (0] 4 ] [ Cancel ]

P Click Apply
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PP Workspace Preferences Lab - EGL Editor

Folding
Edltor Preferences Folding - Collapse or hide seckion of text in the editor

* You can change the editor’s appearance, [7] Enable folding
and how it treats and displays your source
Statements Murmber of property block lines needed ko enable folding:| S

Initially fold these elements:
[ ]comments

|:| Parks
[ ]Mested Partsifunction and Form)
Imports
P UN-check: Annotate errors as you type Explict SQL/DLI Statement

[ ] Properties Block

bvpe Filker bext Editor Source Styles
Data ~!| EGL Editor settings.— EGL Style Preferences
= EGL o
Bidi Preferences [ sk line numbers s 4 Background color
P (%) System Default ) Custom:
Debug annotate errors inkext e
Default Buid Descriptor | o oo STOSIMESXE e
= Annckate errars in D’yg[yisw'r'i;iler Element:
Falding~ [ Annotate errors as you type Colar: E]
Formatter [% """""""""" Reserved Words
Organize Imparks e Strings [ ]Eald
——— Sinagle Line Comment
SOUrTe Styles - Multi Line Comment
Templates
Optionally — feel free to try out other editor
preferences
P Click Apply S
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P OPTIONAL Workspace Preferences Lab — EGL Editor Templates/Modify Defaults

. . qet eql-core get I:u';.f.pcusitil:un with ... an -

& BeS|deS add|ng new Statements, yOU goto eql-core goto label stakement: an
1 icti 1 handler eql-core basic handler an

may Want to mOdIfy the eXIStIng Edltor handler eql-isf J5F handler part an
Templa’[eS . handler eql-jsf J5F handler part wit. .. on

handler eql-jsf PageDesigner Page ... an
> Change the defaUItS i eql-core if statED\Ssnt an

| = i T in T e

» Add new Properties

./_/"/' @ Edit Template |z|®
>>I Optlonal WO rkShOp /,/"/ Narne: | handler | Context: |egl-jsf w | [#] dutomatically insert
» Select the handler eg |_j sf - Descripkion: | Pagelesigner Page Code generation template with component tree access |
w i Pattern: ackage ${packageldentifier}; e
PageDesigner Page Code packags ${packag b 2
generatlon template Wlth import $4interfacePackageldentifier} . *;
33
Component tree access template handler ${isfHandlerMame} type J5FHandler
JonZonstructionFunction = ${onConskruckiond, .. .. .. .. .. _ .. _. —
wiew = "${jsplocation}$4{jspMarne]", K=l Te=) ey o e = Ny |l g =T
> Clle Edlt . viewRootVar = ${uiviewRoot}y — T T T T T T T T
> R - " : : - ${uiviewR ootk UTviewRook;
- - v
cancelOnPageTransition=yes, =
» Click OK @ oF l [ Cancel ]
= To save your edits .
» Click OK i e fanrimctin! 1
= To save your Template preferences || [[Juse code formatter
; [Resture DeFauIts] [ apply ]
[ Ok, ] [ Cancel ]
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Help

Pt
i) Welcome

There is a robust help
system with
documentation and
examples available in
many categories:

= Keyword search
= Category search

= Web Resources

» Points you to the EGL
forum and home page on
DeveloperWorks

= Tutorials Gallery

» Contains additional in-the-
box education samples

= Samples Gallery

» Contains working, sample
applications

= Cheat Sheets

» Contains step-by-step
“how-t0” instructions

¢ s[Elo
-

Table 1. wglib system Functions System
Function)Invocation Description resulk =
compareBytes ( warl | varlsubIndex ,
warlSublength,

compareiunmi)

The walib. comparefum() swstem Function
compares the contents of bwa numeric wariables
of the same type and determines whether the
first is less than, equal to, or greater than the sec
FloatingSunie)

The wglib.FloatingSumi) system Function converts
twio numbers to double-precision Floating poink
type and returns their sum, valib, floatingsum) is
one of a number of Functions maint
FloatingProduct()

The wgLib FloatingProduct) system function
pramates bwo numbers o double-precision
floating poirk type, multiplies thern together, and
returns the produck, waLib floatingProduct
floatingDifferenced)

The wglib.FloatingDifferencel) system Function
converts bwo numbers to double-precision Floating
poirk type, subtracts the second frorm the First,
and returns the difference, v

Floatingrodi)

The walib.FlaatingMad() system Function promotes
two numbers to double-precision Floating poink
type, divides the numerator by the denominator,
and returns the remainder, The result
FloatingGuakient()

The wgLib. FloatingQuotient!) system Function
promotes bwo numbers to double-precision
floating point type, divides the numerator by the
denominator, and returns the quotient, IF
gebYAGSysTvpel)

The walib, getvaGaysTypel) system function
identifies the target swstem in which the program
is running. The function is supported only if you
are running in Yisualdge & Generatar
concatenatel)

The wglib.concatenatel) swstem function
concatenates bwo characker variables, When bwo
character variables are concatenated, the
following actions ocour: Any trailing spaces or nulls
recordiame in asynchlink element

The recordMame property of the asvnchLink
element in a linkage options part specifies the
narne of the record that is used in the
walib, start Transaction system

setSubstr()

Search scope: Al topics

&7 Search
Dwvnamic Help
Key fasist, ., Ckrl+5hifk+L
Tips and Tricks. .,
Developing > Developing EGL appli Documentation Feedback,
cornpatibility Web Resources
EGL libra ry e W) (7 Tutorials Gallery
T Samples Gallery
The system functions are Cheat Sheets. ..
Tahle 1. ) system functions
System function/Invocation Description

reswlt = comparebytes (vard,
varl Subindax, varisSublength, varz,

var2subindesx, var2sublength)

reswlt = comparelum (warl, var2)

result = comparestr (vari,
warl Sublndex, varlSublength, varz,
wvar2subindesx, var2sublength)

reswlt = concatenate (target,
Fource)

reswlt = concatenateBytes (farget,
SOLrCE)

reswlt = concatenateWithSeparator
{target, source, separator)

connectionService (useriD, password,
SEFVEr e [, product, refease [,

connectiondotion]])

copyBytes (target, targetSublndax,
targetsublength, source,
souwrcesubindeyx, sourcesublength)

copyStr (target, targetsubindes,
tarnatrSuhl anoth, solunne

Cormpares substrings within warl
and war2, and returns an INT (-1, 0,
or 1) to indicate which of the two is
greater.

Compares the contents of two
numeric variables of the same type
and returns an INT {-1, 0, or 1} to
indicate which of the two is greater.

Cormpares substrings within war?
and war? according to the local
code page, and returns an INT (-1,
0, or 1} to indicate which of the
two is greater.

Concatenates two character
variables.,

Concatenates two character
variables without regard to content,

Concatenates two character
wariables with separator characters
between them.

s Allows a program to connect
to or disconnect from a
databasze at run time.

e Optionally receives the
databasze product name and
release level,

Copies one value to another,

Copies characters from one wariahble
tn annther
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System i Connections

Topics:

Creating a New Project

Creating a DB2/400 Connection

Defining a DB2/400 Runtime Data Source

Adding JT400 Toolkit to Your Project
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» Lab - Launch RBD and Create a New Project

(If RBD is not
already up and

$ Web - Rational® Business Developer™

running)
ZEM Edit  Mavigate Search Project Fun Window  Help
ARSI i Static Web Project

[ ] From the Cpen File. .. % Dynamic Weh Project

Windows start

menu launch [ eb Page

RB D {57 WWeb Page Template

Egs=s
o T HTML

= From the initial 4 Folder

prompt, specify ¥ File

Or brOWSG tO and Bename... Fz Fi.‘: Example

select your £ Refresh FS —

Workspace Conwert Line Delimiters To v [ Other... Chrhh
- Select F| Ie 9 Switch Workspace r

New - Project restart

to create a new g Impart. .

project £ Export..,

Propetties Alk+Enter
Exit
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»| Lab — Create a New Project

= EXpand EGL £ New Project
f0|der Select a wizard

\Wizards:

- BX)

A,
2 <

'[;_'35 Daka Design Project

: '[§ Java Project

i & Java Project From Existing Ant Buildfile
‘:{EZ Plug-in Project

= General

[ Business Inteligence and Reparting Tools
= cvs

= Data

= EdL

= EXB

(= Graphical Modeling Frarnework,

= Java

= lavaEE

L A = B R = e SRR =

[

[ £

[]show &l wizards,

) = Back Mext = Finish

Cancel

© 2009 IBM Corporation 39

@



»| Lab — Create a New Project

= Select “EGL
PrOjeCt” £ New Project

Select a wizard —
H 7] ” EGL Project Wizard
= Click “Next -
\Wizards:

|tvpe filer text

'[;_'35 Daka Design Project
: '[§ Java Project
i & Java Project From Existing Ant Buildfile

‘:{pﬁ Plug-in Project
[= General
[ Business Inteligence and Reparting Tools
= Cvs =
= Data
== Edl

B EYEGL Project

= EXE
= Graphical Modeling Framewark,
[= lava

[]show &l wizards,

[

[ %

e - 1 B
(2) < Back Mlext = Finish Cancel
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»| Lab — Create a New Project

= Enter Project
Name as
“EGLWEB400”

= Select “Web
Project” radio
button

= Click “Next”

£) New EGL Project B (=1E3

MNew EGL Project

Enter the name for the new project and select a project bype f !

Project name: | EGLWEE<00| |

EGL Project Types
(%) Web Project

() General Project

() Plug-in Project
{3 Rich UI Project

An EGL-enabled web application that contains Web pages, Web services, or bath

& project For general use, including EGL batch, legacy Text UT (3270/5250), reparting, Consale LI,
and EGL Service applications

& rich client project that uses EGL code to create a Windows or UMI%-based Fat client application

& project containing EGL Rich UT applications, custom widgets, or bokh

s e
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»| Lab — Create a New Project

£ New EGL Project
H 13 ”
= Click “New New EGL Web Project

Specify the general settings For the EGL Web Project| f - !

Target Runtime

Select a target runtime {application server) For the project. By choosing a runtime now, vou set options in the project to wark
with the server, You can change the target runtime later From the project properties.

\WebSphere Application Server v7.0 stub b | [New... ]

Build Descriptor Opkions

EGL build descripkors contain options which customize the process of generating EGL ko Java or COBOL

(¥} Create a new build descriptor

(T Select an existing build descriptor

(") Do not create a build descripkar

[ ]show Advanced Settings

'f':’:' =k = Einish H Cancel
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»| Lab — Create a New Project

& New Server Runtime Environment

New Server Runtime Environment

= Expand
“Apache” folder

Define a new server runtime environment

Select the type of runtime environment:

|ty|:-e filber kext

= Select “Apache

= &pache
[ Basic
(== 16M
B 1BM websphere v6.0

Tomcat v5.5”

= Click “Next”
== JBoss
[= ObjectWeb
= Oracle

WebSphere Application Server w6.0
WebSphere Application Server «7.0

\WebSphere Application Server 7.0

[]create a new local server

@

- BX

£ New Server Runtime Environment

New Server Runtime Environment

Define a new server runtime environment

Download additional server adapkers

Select the type of runtime environmenk;

|t':.f|:|e Filker ket

=== spache »
#pache Tomcat w3, 2
#pache Tomcat w4.0
Apache Tomcat ve, 1
Apache Tomcat +5.0

Apache Tomecat 5.5

EE ] ) D

#pache Tomcat va.0
[ Basic
== IBM
B 1BM websSphere v6.0
WebSphere Application Server w&.0

S TRV Wy NN Y ¥ S O

#pache Tomcat v5,5 supports J2EE 1.2, 1.3, and 1.4 ‘Web modules,

e —

Cancel

oo
]
\.:J.-
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»| Lab — Create a New Project

= Click “Browse”

= Open “Program
Files” folder

= Open “Apache
Software
Foundation”
folder

= Select “Tomcat
5.5”

= Click “OK”

£ New Server Runtime Environment

Tomcat Server

Specify the installation directory

Marmne:

B(=1/E3

| bpache Tomcat v5.5

Tomcat installation directory:

| [ Browse, .. ]

apache-tomcat-5.5,25 [Du:uwnlu:uad and Inskall. .. ]

JRE:

|'-.-'-.-'-::rkbenu:h defaulk JRE

Browse For Folder

Select Tomcat installation directary,

= |5 Program Files
I5) activeFDF
I Adobe
I ahead
= L) Apache Software Foundation
SR Tomcat 5.5
I3 bin
I3 comman
|5 conf
=70 logs

.

|

53

||

Falder: | Tomcat 5.5

[ Make Mew Folder ] [ O ] [ Cancel
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»| Lab — Create a New Project

= Click “Finish”

£ New Server Runtime Environment

Tomcat Server

specify the installation directory

Mame:

| Apache Tomcak +5.5

Tomcat installation direckory:

- BX

| C:\Program Files\Apache Software Foundation) Tomcak S | |

Browse, .,

apache-tomecat-5.5,25 [Dl:uwnll:uad and Install, . ]

IRE:

|'-.-'-.-'u::rkl::enu:h default JRE

w | [ Installed JREs...

]

@

Einish

l [ Zancel
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»| Lab — Create a New Project

» Select “Apache
Tomcat v5.5” as
the Target
Runtime

= Click “Finish”

83 New EGL Project |:|@@

New EGL Web Project
Specify the general setkings for the EGL Web Project

Targek Runkime

with the server, You can change the karget runtime later from the project properties,

Select a karget runtime (application server) for the project, By choosing a runtime now, you set options in the project bo work,

Apache Tomecat v5.5

] o]

Build Descriptar Options

{(#) Create a new build descriphor

{1 5elect an existing build descriptor

() Da nat create a build descriptar

[]show Advanced Settings

EGL build descriptors contain options which customize the process of generating EGL to Java or COBOL

Einish

l ’ Cancel
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»| Lab — Create a New Project

= Your
EGLWEB400
project is created

= Close
“Technology
Quickstart” tab

File Edit Mavigate Search Project Run  Window Help

i P E WS R -0 Q @ @Y QI IR | @ web |

[[5 Project Explorer &3 : Gallery = 8]

==
& EGLWEBHR

[Blra 52~ 285 | [Sl= |f@m| = O
T

Mo data components Found,

u Cone

() Technology Quickstarts 3 52 52 », =5

An outling is nat avaiable,

>

Help for Web application development

Featured help topics

=B pow that you have created a Web project, click the links below to learn about the different things you can do, using Web
tools:

(B Creste and import Web pages and resources
Learn how to populate your Web application with the required Web pages and resources for your Web application.
(@ Define web application flow
Use the Web Diagram Editor to define a flow for your application.
(B Create Web 2.0 applications
Learn how to create Web 2.0 applications.
B Develop 15F applications
Learn how to create Web-based user interfaces using JavaServer Faces.
(B Develop Struts applications
Use Struts to create a Web-based user interface.

Create a Web site structurs

@

Use web site navigation to organize your pages in a hierarchy and generate navigation links and site maps.

5|

Develop Web services
Learn how to use Wweb service tools to discover, create, and publish Web services that are created from Java
beans, enterprise beans, and WSDL files.
(B Accessing data using JPA
Learn how to create a Web page that accesses data using JPA technology.
(B More Web topics
Learn more about the technologies and concepts behind software development toals.

To view other Technology Quickstarts, click Help > Technology Quickstarts,

& Provide feedback =
v

©pen on creation of new projects

EL Problems 5% . 4% Servers | ] Properties | 5 quick Edit | E1 Cunsolé ¥ =0

|Ditems

Description Resource Path Locat... Type

© Create anew Web diagram: (8%) [ &
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System i Connections

Topics:

Creating a New Project

Creating a DB2/400 Connection

Defining a DB2/400 Runtime Data Source

Adding JT400 Toolkit to Your Project
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»| Lab - Create a DB2/400 Connection

= From Window =
Preference

= Expand “EGL”
folder

= Click “SQL
Database
Connection

= Click “New”

& Preferences

|t';.f|:|e filker kext

o-E-E

- E-E-E-E -

Lol

)

=3

General
Agent Controller
Ank
Baclward Compatibility
Data Management
Ecore Diagramm
EGL
Bidirectional Text
Debug
Default Build Descriptor
Editor
Generation
Page Designer
Rich LI
Service
s0L
SOL Database Connecti
Help
InstallfUpdate
Java
Java EE
JawaScripk
JET Transformations
Jra
Jvthon
Modeling
Plug-in Development

|Z_

SOL Database Connections

Connection details

E3 BIRT Classic Models Sample Database
3 Derby Sample Connection

Property

Yalue

Secondary Authentication I0:

[Restore Defaults ] [

Apphy

] g

l

[8]4

J{

Cancel

)
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»| Lab - Create a DB2/400 Connection

&1 New Connection |Z|®

Connection Parameters

= Select a database
manager: DB2 for i5/0S

Select the database manager, JDBC driver, and required connection parameters,

Connection identification
Use default naming convention

u JDBC drlver AS/4OO Connection Mame: |
toolbox for Java Default

Select & database manager: ~ IOBC driver: |.C\S,|'4DD Toolbox: For Java Default w | A
[DEZ For i5/05
DBZ For Linwe, UM, and Windows Properties
DEZ F 05
L H Ost Derb;’r 3 Host: | iserissd. demos.ibm. com |

Informi:

1 1 1 User name: 4

iseries.demos.ibm.com Oracle | eaipg |
S0L Server Password:

Connection URL: | jdbec:as400:iseriesd. demos. ibm, com; prompt=False |

= User name: egldrpg

= Password: egl4you

= Check “Save password”

= Click “Test Connection” ® O T | T

£ New Connection E'

i ) Conneckion succeeded,

= Click OK
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»| Lab - Create a DB2/400 Connection

= Un-check “Disable
Filter”

= Click “Selection”

= Scroll down and check
“EGLLABV7XX” library

= Click “Finish”

Filter

Specify a filker by selecting a predicate and entering a value or by indicating whether ta include or exclude a selection of items.,

(:) Expression

() Selection

|Include selecked items W

] EoLLL

[] EoLzC

] EDMHL

[1 EDTLHM
] EpzeC
EGLLABY 7
] EGLMOR7S
] EGLroT
[ EGLy?t
] ELAMGD
[ ELMERLIE
] ELumn

[ EMERGYS

] EMPLOYES
1 EMsarnEay

~
— Select ol
| | Deselect Al

£

[oisable filker

o
I3
)

Finish ] [ Cancel
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»| Lab - Create a DB2/400 Connection

81 Preferences

u CI|Ck “Apply” |t'f|38 Filker text | S0L Database Connections =S b4
Genatal LS '
Agent Conkroller i Connection details
&nk - .

- C I i Ck O K Backward Compatibilicy E.__H BIRT Classic Models Sample Database
Data Management E_—j Derby Sample Connection
Ecore Diagram E3 iseriesd.demos.ibm.com
=)~ EGL

Bidirectional Text
Debug
Default Build Descriptor
Editor Properties:
Generation
Page Designer Property Yalue
Rich LI Database DEz UDE iSeries YSR4
Service IDBC Driver Class com.ibm, as400, access, AS400IDBCDriver
saL Class LDFation D:'|,IBM'|,SDP_Shared'l,plugins'l,n;om.ibm.datatools.db2.iseries_3.l3.3.v2. &
: Connection URL jdbe: as400iiseriesd, demas. ibm.com;prompt=False
SGL Database Connecti User D egidrpg
Help
InstallfUpdate
Java
Java EE
Javascripk
JET Transformations
A Secondary Authentication I0:
Jython
Maodeling |
( Flug-in Developmentl v ’Restore Qefaultsl ’ — ]
< | = |
@ ’ (a4 ] [ Cancel l
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System i Connections

Topics:

Creating a New Project

Creating a DB2/400 Connection

Defining a DB2/400 Runtime Data Source

Adding JT400 Toolkit to Your Project
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»| Lab — Define a DB2/400 Runtime Data Source

= Right-click over EGLWEBA400 project and select

Properties

= Click EGL Runtime Data Source

|7 Project Explorer i3

&
= sery

S
[@ pa 2

Mo data comp

GaIIery =
B %

Mew

Show In

|2 Copy
B2 Copy Qualified Mame:
[ Paste
# Delete
Build Path
Refactor

Impork
Export

& | Refresh
Close Project
Clase Unrelated Projects

Organize Used Forms
Qrganize Imports
Forrat

Open in Parts List
Generate With Wizard. ..
Generate

7 Links

E® Transform
Yalidate
Add 5QLI Support...
Run As
Debug As
Profile As
Instrumentation Source
Team
Campare ‘With
Restore from Local History, .,
‘web Development Taols
PCE Tools
Java EE
Services
IPA Tools
Saurce

Properties

]
=2

Al+Shift+

Chr4C

Chrl+y

Delete

Al+5hift+T

Fa

Alt+Enter

3

»

v T v orow

* v T rorow

b

1=

81 properties for EGLWEB400 - B
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|ty|:-e filber ket | @ Daka Source name (resource-reference-name) can not be null & =
Resource Enter the infarmation that is used ko conmect ko a database at runtime.
BeanInfo Path
Builders () Load vwalues from a data tools connection
Code Coverage
Default Package "
EGL Build Path .
EGL Defaulk Build Descriptors © Inputimodi'y values manualty
EGL Project Features
Resource reference name: | |
Java Build Path
Java Code Style JHDI name | |
Java Compiler
Java Editar [Joata source requires a userid and passwaord o obtain a connection
Java EE Module Dependencies
; User IT: | |
Javadoc Location
Jawvascripk Password: | |
JavaServer Faces
JDBC Connections Floenioy ot d fi i h lication i it kst
5P Fragment eploy database and connection properties when application is run on unit test server,
Project Facets DE vendor nane: | |
Project References e |
RunDebug Settings ata source classname:
Server Database narme: | |
Setvice Policies
Target Device Settings Class Location: | |
Targeted Runtimes Database location {optional): | |
Task Tags
Yalidation Server name {optional): | |
eb Content Settings Port number (optional): | |
‘Web Project Settings
®Doclet
< >
':':’:' [o]4 ] [ Cancel ]
—_————
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»| Lab — Define a DB2/400 Runtime Data Source

Click “Load values
from a data tools
connection

= Select
iseriesd.demos.ibm.
com from the pull
down-list

= Click input/modify
values manually

= Change the JNDI
name to “jdbc/i5”

= Click OK

!type filker text |

Resource

BeanInfo Path
Builders

Code Coverage
Defaulk Package

EGL Build Path

EGL Defaulk Build Descriptors
EGL Project Features
EGL Runtime Data Source
Java Build Path

Java Code Style

Java Compiler

Java Editor

Java EE Module Dependencies
Javadoc Location
Javascript

JavaServer Faces
JDBC Connections

J5P Fragment

Project Facets

Project References
Run/Debug Settings
Server

Setvice Policies

Target Device Settings
Targeted Runtimes
Task Tags

Yalidation

Web Content Settings
‘Web Project Settings
®Doclet

e

EGL Runtime Data Source

€ Properties for EGLWEB400 - B

oo -

Enter the infarmation that is used ko conmect ko a database at runtime.

(*) Load values from a data tools connection

Connection: |}

) Inputimadify values manualky

8 Properties for EGLWEB400

!type filker text |

Resource

BeanInfo Path
Builders

Code Coverage
Defaulk Package

EGL Build Path

EGL Defaulk Build Descriptors
EGL Project Features
EGL Runtime Data Source
Java Build Path

Java Code Style

Java Compiler

Java Editor

Java EE Module Dependencies
Javadoc Location
Javascript

JavaServer Faces
JDBC Connections

J5P Fragment

Project Facets

Project References
Run/Debug Settings
Server

Setvice Policies

Target Device Settings
Targeted Runtimes
Task Tags

Yalidation

Web Content Settings
‘Web Project Settings
®Doclet

ibrn.com
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55

EGL Runtime Data Source ) -
Enter the infarmation that is used ko conmect ko a database at runtime.
() Load values from a data tools connection
() Inputimadify values manually
Resource reference name: | jdbefis |
IJHDI name | jdbefis] |
Daka source requires a userid and password ko obtain a connection
User 1D | eqldrpg |
Password: | ASvEEuRE |
Deploy database and connection properties when application is run on unit test server,
DE vendar name: | DEZ UDE iSeries |
Data source classname: | corn.ibm, 25400, access, AS400JDBCConnectionPoolDataSource v !
Database name: | iseriesd. demas.ibm.cam |
Class Location: | D:'|,IBM'|,SDPShared'l,pIugins'l,com.ibm.datatools.de.iseries_S.D.3.v| E]
Database location {optional): | |
Server name {optional): | iseriesd. demos.ibm.com |
Port number (optional): | |
[o]4 ] [ Cancel
—_———
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»| Lab — Define a DB2/400 Runtime Data Source

= (Click “Load values from
a data tools connection

= Select

iseriesd.demos.ibm.com
from the pull down-list

= Click input/modify values | « xew

manually

= Change the JNDI name
to “jdbc/is”

= Click OK

= Click “Yes” on Update
build option?

& Update build options?

!type filker text

Resource
BeanInfo Path
Builders

Code Coverage
Defaulk Package
EGL Build Path

EGL Project Featur

EGL Runtime Data 5

Java Build Path
Java Code Style
Java Compiler
Java Editor

Java EE Module De

Javadoc Location

JavaServer Faces
JDBC Connections
J5P Fragment
Project Facets
Project References
Run/Debug Setting
Server
Setvice Policies
Targek Device Sektifl
Targeted Runtimes
Task Tags

Yalidation
weh Content: Settiry
‘Web Project Settin

®Doclet

EGL Defaulk Build Descriptors

8 Properties for EGLWEB400

€ Properties for EGLWEB400 - B

EGL Runtime Data Source

Enter the infarmation that is used ko conmect ko a database at runtime.

(*) Load values from a data tools connection

oo -

Connection: |}

!type filker text |

Resource

BeanInfo Path

Builders

Code Coverage

Defaulk Package

EGL Build Path

EGL Defaulk Build Descriptors
EGL Project Features
EGL Runtime Data Source
Java Build Path

Java Code Style

Java Compiler

Java Editor

Java EE Module Dependencies
Javadoc Location
Javascript

JavaServer Faces

JDBC Connections

J5P Fragment

Project Facets

Project References
Run/Debug Settings
Server

Setvice Policies

Target Device Settings
Targeted Runtimes

Would you like to update the default build options

A} EGLWEB400W ebBuildOptions Faor this project with the values in the EGL

Rurnkime Data Source page?

) Inputimadify values manualky

EGL Runtime Data Source () -

Enter the infarmation that is used ko conmect ko a database at runtime.

Jdbrn,com

() Load values from a data tools connection

() Inputimadify values manually

Resource reference name: | jdbefis |

IJHDI name | jdbefis] |

Daka source requires a userid and password ko obtain a connection

User 1D | eqldrpg |

Password: | ASvEEuRE |

Deploy database and connection properties when application is run on unit test server,

DE vendar name: | DEZ UDE iSeries |

Data source classname: | corn.ibm, 25400, access, AS400JDBCConnectionPoolDataSource v !

Database name: | iseriesd. demas.ibm.cam |

Class Location: | D:'|,IBM'|,SDPShared'l,pIugins'l,com.ibm.datatools.de.iseries_S.D.3.v| E]

Database location {optional): | |

r5_<| br name {optional):

unber {optional): | |

| iseriesd. demos.ibm.com |

© 2009 IBM Corporation

[[JRemember this decision (o] ] [ Cancel
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»| Lab — Define a DB2/400 Runtime Data Source

= Copy context.xml from jt400 folder T Ex
File Edit Wiew Favorites Tools  Help ,'
= Paste it to EGLWEB400 -> O ook - — iy A0 seerh gy Fokar [ |
WebContent > META-INF folder Adress [© HA400__ v @
Falders X Marme
if:l download A cn:nntEe::-::t.::-::r|'||
. . . . . . [T EGL7S1Class ﬁdlﬁjcc.jar
= The context.xml file is an optional file which contains = Sm e 4] dbzice license_cisuz.jar
a <Context> tag (Context Fragment) for a single & Furrufastz |4l] dbi2icc_icense_cu.jar
Tomcat web application. This can be used to define ) House 4] 400, jar
certain behaviours for your application, JNDI =) 18M Download <] oybe14.jar
resources and other settings. Qe ﬂ:g:ﬁ:gff
I iron
= The context.xml file was introduced in Tomcat 5, to e
remove Context settings from the server.xml file Q3 liufa_photo
— ) u:l rnisc |._|;_‘| Project Explarer 23 Gallery = OB
|) osgint
= ohs =
= The Context Fragment can be embedded in - — = ==
server.xml, placed in the <CATALINA>/conf folder, &) Tahnicolor = EGLWEBADN _
or placed inside each application in the META-INF ) Tmeshest 8 Deployment Descriptor: EGLWEB400 >
folder in a file called context.xml. The META-INF (= EGLSource
method is preferred as this means changes to the q'ﬁ Java Resources
context don't require Tomcat to be restarted. You @ \eb Diagram
can restart your application by modifying web.xml = JavaScript Support
when automatic reloading is active, or reloading & Security Editor
manually with the Tomcat Manager. & web Site Mavigation
== WebContent
= r'-'1ET'-Ir'-JF
= Your context.xml file should be installed in the ) AI"-.IIFEST.MF
META-INF folder of your application, as META- B theme

INF/context.xml. [ WEB-INF

l=F Servers
= Switching to the use of a context.xml file removes all

dependencies from server.xml, making the
application much more portable and easier to deploy.
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System i Connections

Topics:

Creating a New Project

Creating a DB2/400 Connection

Defining a DB2/400 Runtime Data Source

Adding JT400 Toolkit to Your Project
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» Lab - Add JT400 Toolkit to your Project

Access Obijects (Programs, Files,
Data Areas, Data Queues) on
an iSeries box requires the

JT400 toolkit in your build path.

= Click “Java Build Path” on
“Properties for EGLWEB400”

= Click “Libraries” tab

= (Click “Add External JARS”

89 Properties for EGLWEB400

itvpe filker bext |

E-E-E

Resource

BeanInfo Path

Builders

Code Coverage

Default Package

EGL Build Path

EGL Default Build Descriptors
EGL Projeck Features
EGL Runtime Data Source
Java Build Path
Java Code Style

Java Compiler

Java Editor

Java EE Module Dependencies
Javadoc Location
Jawvascript

Javaserver Faces

JDEC Cannections

J5P Fragrenkt

Project Facets

Project References
Refactoring Histary
RuniDebug Settings
Server

Service Policies

Target Device Setkings
Targeted Runtimes

Task Tags

Walidation

Weh Content Settings
‘“Webh Project Settings
s“Doclet

Java Build Path

& - -
| [ source | = Projects i B Libraries | e’{} Crder and Export
JARs and class folders on the build path:
B Apache Tomcat 5.5 [Apache Tomecat +5,5] add 1ARs, ..

Bl EAR Libraries
B JRE System Library [jdk]
=i wWeb App Libraries

Add External JARs. ..

Add Yariable. ..

Add Library. ..

Add Class Folder. ..

[
[
[
l
l
[

Add External Class Folder..

l
l
|
]
]
]
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» Lab - Add JT400 Toolkit to your Project

JAR Selection

= (Click “Add External JARS” Losk i | (5 1400 v 02> E
1 r |&/] dbzjec. jar
" Open ]t400 fOIder ‘Q ﬂdb2jcc_|icense_cisuz.jar
My Recent i] db2jcc_license_cu.jar
Diocuments |4/) k400, jar
« . . . “ ” — |2/ ajbe14. jar
= Select “db2jcc.jar” Click “Open [ [Asabcrm
Deskiop ﬂ sqlidbe.jar
= Repeat to add: _/ o
. . . . # Properties for, EGLWEB400 E]
» Db2jcc_license_cisuz.jar ; -
ST - [tvpe filer text | Java Build Path &~ &
} Db2JCC ||Cense CUJar Resource I r—— : : -
B o BeanInfo Path | €2 Source | = Projects | B Libraries | &5 order and Export
} Jt400 Jar Builders 1aRs and class folders on the build path:
EU?B Eo:er:age @ dbZjcc_license_cisuz. jar - Hi\jt400 add J6Rs.., w | [ Qpen l
E;La;uildicathge @ dbZjcc_license_cu.jar - H:4jt400
3 dhzice. jar - Hilj4a0 Add External JARs. . v | Cancel |

EGL Defaulk Build Descriptors
[ ] C I i Ck “O K” EGL Project Features
EGL Runtime Diata Source
Java Build Path
Java Code Style
Jawva Compiler
Java Editar
Jawa EE Module Dependencias

(g jE400.ar - H:jt400
=, Apache Tomcat v5.5 [Apache Tomcat v5.5]

[ ]
| |
[ addvariable.. |
=i, EAR Libraries [ add Library. .. ]
[ ]
[ l

B JRE System Library [jdk]
=, Web App Libraries

EH-E-E-EE--E-E-E

Add Class Folder ...

Add External Class Folder. ..

Javadoc Location
. [ Edi... |
JavaScript
JavaServer Faces [ Remove ]

JDEBC Connections
J5P Fragmenk
Project Facets
Project References
Refactoring History
Run/Debug Settings
Server
Service Policies
Target Device Setkings
Targeted Runtimes
Task Tags
Walidation
‘Web Content Settings
‘Web Project Settings
WDoclet

.Y
e

@ oK ] [ Cancel
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»| Lab - Setup Targeted Runtime

= Click “Targeted Runtime” on
“Properties for EGLWEB400”

= Check “Apache Tomcat 5.5”
= Click “Apply”

= Click “Yes” if asked to
“Update build options”

= Click “OK”

8 Update build options?

, Would vou like to update the default build options
r EGLWEB400WebBuildOptions Faor this project with the values in the EGL
Runtime Daka Source page?

[] remember this decision

8 Properties for EGLWEB400

!type filker text |

Resource
BeanInfo Path
Builders
Code Coverage
Defaulk Package
EGL Build Path
EGL Default Build Descriptors
EGL Project Features
EGL Runtime Data Source
Java Build Path
Java Code Style
Java Compiler
Java Editor
Java EE Module Dependencies
Javadoc Location
Jawvascript
JavaServer Faces
JDBC Connections
J5P Fragrment
Project Facets
Project References
RunDebug Settings
Server
Setvice Policies
Targek Device Settings
Targeted Runtimes
Task Tags
Validation
‘Wweb Content Settings
Web Project Settings
wDoclet

E
|

Targeted Runtimes

E@npache Torcat v5.5

[] |Z websphere application Server w7.0 stub

[ 5how all runtimes

If a runtime that you want to select is not displayed or is disabled you may need to uninstall one or more of the

currently installed project Facets,

Uninstall Facets, ..

’Restore Defaults ] ’

Apply

|

[

K

] [ Cancel

X
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» Lab - Setup jt400.jar

€ Properties for EGLWEB400 - B
w

. CIiCk “J ava BUiId !tvpe filker ket | Java Build Path =
Path” on “PI’OpeI”[ieS Resource
for EGLWEB400” i

Code Coverage
Default Package
EGL Build Path

L CIiCk “Libraries” tab EGL Default Build Descriptors Bl JRE System Library [idk]

=i wWeb App Libraries

[ source | = Projects | =i Libraries | Y Order and Export
JARs and class folders on the build path:

=, Apache Tomcat +5.5 [Apache Tomcat +5.5]
Bl EAR Libraries

fdd JARS. .,

Add External JARs. ..

EGL Project Features Add Yariable. ..
Java Build Path Add Library...

Java Code Style

Java Compiler

Java Editor

Java EE Module Dependencies

Javadoc Location

JawaScript

Javaserver Faces
JDEC Cannections
J5P Fragrenkt
Project Facets
Project References
Refactoring Histary
RuniDebug Settings
Server
Service Policies
Target Device Setkings
Targeted Runtimes
Task Tags

Walidation
Weh Content Settings
‘“Webh Project Settings

s“Doclet

= Click Add External
JARS”

Add Class Folder. ..

[
[
EGL Runtime Data Source {
l
[

E-E-E

Add External Class Eolder. ..
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» Lab - Setup jt400.jar

€ Properties for EGLWEB400 - B
w

. CIiCk “J ava BUiId !tvpe filker ket | Java Build Path =
Path” on “PI’OpeI”[ieS Resource
for EGLWEB400” i

Code Coverage
Default Package
EGL Build Path

L CIiCk “Libraries” tab EGL Default Build Descriptors Bl JRE System Library [idk]

=i wWeb App Libraries

[ source | = Projects | =i Libraries | Y Order and Export
JARs and class folders on the build path:

=, Apache Tomcat +5.5 [Apache Tomcat +5.5]
Bl EAR Libraries

fdd JARS. .,

Add External JARs. ..

EGL Project Features Add Yariable. ..
Java Build Path Add Library...

Java Code Style

Java Compiler

Java Editor

Java EE Module Dependencies

Javadoc Location

JawaScript

Javaserver Faces
JDEC Cannections
J5P Fragrenkt
Project Facets
Project References
Refactoring Histary
RuniDebug Settings
Server
Service Policies
Target Device Setkings
Targeted Runtimes
Task Tags

Walidation
Weh Content Settings
‘“Webh Project Settings

s“Doclet

= Click Add External
JARS”

Add Class Folder. ..

[
[
EGL Runtime Data Source {
l
[

E-E-E

Add External Class Eolder. ..
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EGL/Web QuickStart

Topics:

= |Importing Database Schema

= (Creating Custom Business Logic

= Creating the U.l. Model

= (Creating Dynamic Content Web Pages
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Data Access Wizard

To simplify data access EGL provides custom record types, with “properties”
that enable generation of native database and file 1/O call APIs. You can
write these custom records — or — allow RBD’s tooling to build or derive
them from the relational tables and views you want to access.

= To get you jump-started on your EGL/SQL statements, the RBD tooling
creates design pattern functions, for reading and writing to your database.

= You can create your own custom EGL data access records, design
patterns, functions and SQL statements. But for this simple web
application, let's see how far the wizard-generated code gets us.

Table schema

In your
Database Catalog

Data Access
|

Wizara

Data Access

Functions
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Data Access Application Wizard - Steps for the Upcoming Workshop

¢~ These steps are what you WILL be doing, to import your database:
Create a new Project

Launch the EGL Data Access Application Wizard

Define a connection to your database

Specify any table filtering

Select the tables you want to import

Verify/Specify search keys

Generate

View and customize Results

vV Vv VvV VvV VvV VvV Vv Vv

/ Before starting this process, you must have completed the Workspace Preferences setting for

your SQL generation as described on the slide: Workspace Preferences — Customizing the
Workbench — Modify SQL Preferences
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M Launch the EGL Data Access Application Wizard

Like creating all new resources, you

start from Project Explorer:

= Right-click over \EGLSource\
and select:
New p Other

= Scroll down to, and expand the
EGL folder and select:

» EGL Data Access
Application

= (Click Next >

[ Project Explorer &2

Gallery =0
=

S=3

=& EGLWEB400
@ Deployment Descriptor: EGLWEB400

i

% JavaR
%oy Wieb O

B Java
ﬁg Securil
& webs

¥ Delete
Rename...

X
|I=_= g Import...
f
s
= th{ Expart...

(= & | Refresh

1= Servers

& New

Select a wizard

WWizards:

Organize Used Forms
Organize Imporks

Delste

Ale+Shift+R

FS

| tvpe Filker bext

[£=- Data Access
| Edlipse Madeling Framewark,
- EGl
ﬁ Daka Table
‘EE% Deplovrent Descriptor
5] EcL Build Fil
5”% EGL Data Access Application
ﬁ? EGL Package
- EGL Partlet
B eclL project
;_@ EGL Source File
. &ﬁ EGL Source Folder
X Interface

|*

£

[ 5haw all wWizards,

Cancel

4 7 Project...

[ Data Table
{@ Deployment Descriptar

@ Interface
B Library
[ Package

E@ Pragrar
2B Rich UI Handler

% Service
| & Source File
Y Source Folder

&7 HTML
[&7 15P

@ Wweb Page
|<_><|> ‘Web Page Template

% Example. .

Chrl+M

\2) = Back Mt = Finish
— — — —
_ e
=]
= —
=
67 —_—— =

© 2009 IBM Corporation



M| Select Tables for Import

1. From the Project Name pull down,
select EGLWEB400

From Database Connection pull
down, select
iseries.demos.ibm.com

Check the following tables:
= EGLLABV7XX.CUSTOMER
= EGLLABV7XX.ITEM
= EGLLABV7XX.ORDERS
= EGLLABV7XX.ORDER_ITEM
= EGLLABV7XX.STATETABLE

Click Next >

£ FGL Data Access Application

Define project settings

Specify project location and select tables from relational database,

Project Mame: | EGLWEEB400

Project conkents

Database Conneckion: |iseriesd.demus.ibm.cnm

Cei Select Tables:

Table Mame

[] EliEaLLapyrss. CUSTCALL

| EaLLABY T, CUSTOMER.

(] EllEaLLapy7ss. CUSTOMLS

[ Sl EaLLaBY7:y DEPARTMENT
(] EllEaLLapy7xy. EGLwebt Sample

[] EllEsLLaBy7x, EMPLOYEE

[l FHFE 1 ARy TR
4

[]create web pages

Select All

Deselect all

@ < Back ][ Next = l [

Finish

] l Cancel

© 2009 IBM Corporation
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M| Verify Table Search Keys

s |If a selected table does not have a

Primary Key specified for it in the % EGL Data Access Application I
database catalog, you will be Define the Fields —
prompted to Select a key f|e|d for |t Specify key and selection condition Fields, s‘idj:)_'.;'-:]
This key field is used in the EGL SQL | =
statement generation ) (= cusTomer | ) 1mem | 5 oroers || E5| oroER _ITEM | ) STATETABLE |
o o5 Choose key fields:
@’%?CUSTOMER_ID ~
= It might be the case that CUSTOMER |15 g i
needs you to choose a key field. 0 Geussworo
» Choose: CUSTOMER ID EEMAIL_ADDRESS
tlg Choose search LT Fields: -
= Click ITEM tab: 0o =
» Choose: ITEM_ID 0o ]
]
. g
» Repeat for the followings: |
» ORDERS: ORDER_ID
» ORDER_ITEM: ORDER_ITEM_ID | _ ][ | !
(2] < Back Mext = Firish Cancel

» STATETABLE: STATEABBREV

= (Click: Next >
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M Qualify Table Names

¢ For this workshop you will qualify the

table name with the table’s schema- | Define project creation options |
name (the schema-name is usually ey project crestion optors ® x|
the authorization-id of the table
“owner” — like a DBA, for example). Default package name: |
Data access method
(¥ EL Libraries
O EGL Services
1. Check:
M Qualify table names with schema : ualifv tabls names with schema -
IS L s
[ ]create mulkiple projects
2. Click: Next >
7 < Back ][ Mext = ] [ Finish l [ Cancel
7 = =:5=.,

@ EGL Data Access Application

” X)
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M| Generate

&> Finally, a summary
screen is shown, which
shows your Data Access
import options.

You can expand and look
at them, go back, or just:

= (Click: Finish

£ EGL Data Access Application

EGL Data Access Application Summary

The following settings hawve been specified far the creation of the EGL Data Access

application

Property
Praject Mame

[=)- Database Connection
Table
Table
Table
Table
Table
Default Package Mame
Access Method
Component Projects

Yalue
EGLWEBSOOD
iseriesd.demos.ibrm, com
EGLLABY 7 xx, CUSTOMER.
EGLLABEY Fnx, ITEM
EGLLAEY Fnx. . ORDERS
EGLLABY 7 X . ORDER_ITEM
EGLLABY 7xX. STATETAELE

Libraries
False

- BX

Finish
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What Just Happened? e

L™ Project Explorer &3 Gallery =08
o

The Data Access Wizard created the following 5 &
four sets of resources: S S EawE A
+'z8 Deployment Descriptor: EGLWEED
= [E EaL3ource
+ f_[] com.ibm.eql.jsf
1. Control Records — used in the default Data Access =1+ (L] iseriesddemosibmeom -
Library SQL Statements Control Records { LE ConditionHandlingLib. eql
LB Controlstructures,eqgl
(= f_[] iseriesddemaosibmoom, access
. . . . LE CustomerLib.eql
2. Data Access Libraries — which contain EGL data Data Access | < & ItemLb.ed
access statements (basic data access design Libraries g OrderltenLib.eg
patterns), that generate to SQL statements and -8 CrdersLb.eq|
t| nes \ - LB Statetablelib.eql
rou ~ = [f] iseriesddemosibmeom. data
LB Customer.eql
LB Item.eql
3. Data Access Records — EGL records of type Da"aRAcce:s < & Orderltem.eg
sqlRecord, which participate in the Java and SQL ecords & Orders.cq
generation, allowing you to code at a high-level of e
. = [I] iseriesddemosibmcom, primitivet
abStraCtlon LB DataDefinitions.egl

EGL Dataltems { 42| EGLWES400.eglbld
%5 EGLWEB400,2qldd
4. EGL Dataltems — in DataDefinitions.egl. This file #-2 Java Resources
contains default type definitions for each column in
each imported table. '] See notes for more on
Dataltems
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M| View Results — See What Was Produced by the Wizard

= Expand the four new folders under EGLSource named:

iseriesddemosibmcom.<something>

= QOpen a few of the files produced by the wizard in the
Content Area (Double-click: CustomerLib.egl,
Customer.egl, DataDefinitions.egl, etfc.)
and view the code that was generated.

=  Since we will be covering EGL in an upcoming unit of
this course it is not expected that you understand all —
of what was produced from Data Access import.

= However the default data access code is:

» A nice starting point for doing and learning about
database programming in EGL

» Nice to have been generated (as opposed to hand-coding
yourself)

Let’s do a few specific things to some of these files
(steps begin on the next slide)...

L™ Project Explorer &2

= EGLWERHOD

Gallery

[ §

B

28 Deployment Descriptor: EGLWEESD

= [&’i EGLSource

ﬂj com.ibm.edl, jsf

Control Records

ﬂ] isetiesddemaosibrcanm
|__|%| ConditionHandlingLib. egl

|__|%| Conkral3tructures, egl

Data Access = 4
Libraries

|I| isetiesddernosibmcom, data
|__|%| Custamet, ed|

Trern. eql
Data Access L& em.eg

Records

|__|%| OrderItem.eql
|__|%| Orders.eql

|__|%| Skatetable.eql
= |I| iseriesddemosibmeom. primitivet

EGL Dataltems

da] EGLWEB400.eglbld
%5 EGLWEB400.2qldd

@
£ Java Resources
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|__|%| DataDefinitions, eql

V= ﬂj isetiesddemosibrcomn, access
|__|§| CustametLib,edl
|__|%| ItemLib.eql
|__|%| OrderItemLib,eql
|__|%| Orderslib, eql

\ |__|%| Statetablelib, eql
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=
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| Customize the Default-Generated Code -1 of 2

In \EGLSource\eglderbyr7.access\

= Open OrdersLib.egl and find
the function: GetOrdersListAll

= Click your mouse between the
word get and ordersArray;

» Right-click and select:

» SQL Statement P Add

&o"This causes RBD to insert the
SQL statement it would generate,
inline in your function, allowing
you to customize the data access
code (see next slide)

E COrderslib.egl X

= Function GetOrdersListhill (ordersirray Orders[]
try  ueesas

: 1 . .
get .
if <27 ndo Typing

el=se

end
onExcept
Hanc
end
end
FFEND GetQrd

= ;
Multiple
Feturns =
This fund
The prepsg
SJee the f1
MNote that
The =eled

% =#* # # % %

w
F/BEGIN Get
£/ Hgenerate
= Function Get
Ff oan ir
ordersLi
temp Orc

<

Problems | Tasks | Properties | S¢

There are no genemﬂm_@ub

Show In

Paste
Select all

shift Right

Shift Left
Canment
Incorment
Qrganize Imporks
Add Import

Find/Replace. ..
References
Declarations

Fold Text
Generate

Go ko Line...
Cpen on Selection
Zontent Assist
SOL Record

SO Stakernent

Chrl+2

Ale+Shift+s #

Crl+Y
Chrlf

Chrl+f
Chrl4),
CkrlShift+0
ZEFH-Shift 4+

Ctrl+F

Cerl+HAl+-F
Chrl+iGE
ChrHL

F3
Ckrl4+5Space

out, status 3Itat

EGL.ORDER3™) ;

ht and 30L/Programns
E vou Lo specify pac
a Prepared 3IQL stat
el for dynamnic =es
planations of refere
Cor mwust he set by ¢
ified in order to in

CLion, listcout Orders
erve modified code
ation, listout Qrder
a dynamic array

L Generation Results &3
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| Customize the Default-Generated Code - 2 of 2

w Change the order by

clause to sort the results
of this SQL statement by

the order status
field.

» Note — type & carefully.
= Press Ctrl/S to save

= Indoing EGL/Java
development, most SQL
statement typos are not

caught at compile time, but at

run-time, making them a
royal pain to debug.
See Notes

= But the tooling can catch
these (as we’ll see in an

upcoming section) — want a
hint? (see Optional Exercise

on the next slide)

lEimﬂemUheg b

* Note: to see the 20L behind "get ordershrray™

+ Place cursor hetween the words "get™ and "ordersirray™

w Right-click and =select: Z0L 3tatement > View

w To insert custom 3IQL clauses, select 3I0L 3tatement > Add instea

Y
SYBEGIN GetOrdersListill
¢ Bgenerated - Delete generated tag to preserve modified code
Function GetOrdersListlll (ordersirray Orders[] out, status StatusRec)

trv
get ordersirray with
H=yli
select

EGL.ORDERZ.ORDER_ID, EGL.ORDERS.CUITOMER ID,

EGL.ORDERZ.ORDER AMOUNT, EGL.ORDERZ.ORDER DETATLS,

EGL.ORDERS.CRDER DATE, EGL.CORDERS.ORDER 3TATUS
from EGL.ORDERS

if [ordersirray.getlize(] == 0]
HandleDBFecordNotFound (status, "EGL.ORDERI™) ;
else
HandleZuccess (status)
end
onException [(exception SQLException)
HandleExceptioni(status, exception):
end
end
AARMD GetOrdersTistill]
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M| Test the Customized SQL Statement — 1 of 2 (Set Preferences)

» Optional Exercise: From Window, Preferences, open EGL, SQL Database Connections, and select your
iseriesd.demos.ibm.com connection — then click: OK

Window WgE] —
News Window & Preferences |L|E]
-

Mevs Editar bype filter text | S0OL Database Connections @ o
Open Perspective k lGenceal L
) #gent Controller Conneckion details
Show Yiew r Ant _
_ _ application Diagram E BIRT Classic Models Sample Database T
Custamize Perspective. .. Biackward Compatibiliy E;j Derby Sample Connection -
Save Perspective As,., Data Management Ej iseriesd, demos. ibm, com
Reset Perspective Ecore Diagram 4 northwind
Close Perspective S - o x
Bidirectional Texk
Close All Perspectives Debug
Navigation , Edeift.:ltllt Build Descripkor Properties:
- Seneration Property Walue
L Wiorking Sets ’ Page Designer Database DE2 UDE iSeries YSR4
Rich LI IDEC Driver Class com.ibm.as400. access, AS400IDBCDriver
\Web Browser b B Class LuFatiun I;):'I,IBM'I,SDP.Sha.red'I,pIugins'l,ul:Dm.il:um.datatou:uls.db2.iseries_3.lj.3.v2. =
Connection URL jdbc:as400:iseriesd. demos. ibm. com; prompt=F alse
0L User ID eqldrpg
S0l Database Connecti
[#- Help
i Projects
InstalliUpdate
Jawva
o Java EE
v Jawvascript 3
JET Transformations
IRA
Jython
LPE¥ Editar
Modeling Secondary Authentication I0:
Plug-in Development
Remote Systems |
{ Report Design — bt [Restore Defaults ] [ Apply ]
':'E:' [ o4 l [ Cancel ]
e ————

Jlm
lIn
..||
I
&
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| Test the Customized SQL Statement — 2 of 2

Function GetOrdersLlistlll (ordersirray Orders[] out, status StatusRec)

»w  Optional Exercise: Click your mouse try

inside the select statement. get ordersirray with
w  Right-click and select: Asl
select
= EGLI. ORDERS.CRDER ID, EGL.ORDERS.CUITOMER ID,
SQL Statement » Validate EGL| < Unda Typing Chrl+z ORDER_DETLILS,
EGL  Revert File DER_STATUS
. from EJ
Click OK at the SQL User ID/Password order b .
prompt. EGL
Y Shiow In Alc+Shift+w F
if (orderskrray
HandleDERec
. else
= |f there are SQL problems, you will HandleSucce  Faste Chrk
find out now upon Validating your end select Al Clrlth
statement. onException [EXCept o pighe
HandleException Shift Left
end end Comment Chrl+f
= If there are EGL “host variables” in //END GerOrdersLigeall | Uncemment Cirle,
your Statement, and there are Crganize Imports Chrl+3hift+0
problems with your EGL host- /e A Impert CirkShift+11
VariabIeS, yOU W|“ f|nd Out When you * Multiple Row 3elect rogrammatic Paging
save (Ctrl/S) —— ’ - Find/Replace. .. Chel4+F - - o o
- . f L
» If you are not familiar with the term, Cuick Edit | Servers | Consale | Prablen EZ;;;:;; v l
EGL “host variables” are covered
later in this course. s ta display. Fold Text Chrl+Al+F
Generate Chrl+G
o ko Line. .. Chrl+L
Open on Selection F3
Content Assisk Ctrl+Space
3L Record »
S0 Statement &dd Chr+Shife+-4,
Add with Into
View Chrl+3hifb+
Preferences... w
Rermaove
Reset
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M| Generate the Code Changes

Fin Project Explorer X = O |__|%|OrdersLiI:u.egI

(From Project Explorer)
» Right-click over EGLWeb = i BNy .

|§] Deple
} Se|eCt Generate ﬁ'ﬂ Ll Cpen Type Hierarchy F4
%@y web
E web | 5 Copy Chrl+iC
=-¢E EGLs
=l & [ paste Crrl+y
3 Delete Delete
g III Build Path L4

SOUrce Alk+s5hifk+5 F
Refactor Alk+5hifk+T ¥

Import L4
Export r

Refresh F5

[
[
[
[
[
[ &
= |_]_| e Close Project
[
[
[
[
[
[

Organize Imports
Open in Parks Lisk
Generate With Wizard...

L w

&~ This will generate new Java code for your changes
to the default code created by the Database
Access Application Wizard
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Topic Summary

= Now that you have completed this topic, you should have:
» Used the EGL Data Access wizard to import — from your Derby
database:

= Data Access Libraries
= Data Access Records
= Dataltems (an operational data dictionary)
= SQL call control records

» Customized:
= The Dataltems
= A Data Access Library Function

» Successfully re-generated all of the Data Access import wizard code.

Summary
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EGL/Web QuickStart

Topics:

= Development Model — Terms and Concepts

Importing Database Schema

Creating Custom Business Logic

Creating the U.l. Model

Creating Dynamic Content Web Pages
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The EGL Project Model — Where we are, from 10,000 Feet

&o After generating the Data Access model — and customizing the SQL statements and

Datatltems, you will probably begin coding your business logic. We say probably, because you
could do this in parallel with Data Access Modeling — so the order of the steps is not dependent.
It's only convenient to discuss it as such for this simple web application.

= For your business logic you may want to create:
» Services or Web Services — to move towards a Service Oriented Architecture
» Libraries — to hold independent, granular business logic functions
» Programs —to hold larger-scale business logic (reports, calls to the mainframe, etc.)

=  We will be covering all of these types of EGL logic parts in the Unit that follows the QuickStart,
for now, we’ll create a simple new function in Library — so that you get the 10,000 foot view.

1. Data Access Model

3. U.l. Model

4. Page Development

© 2009 IBM Corporation 81



Create EGL Business Logic

{Function zipTest (zip string) returns| boolean :|

&> Follow the steps beginning on the next - if (zip is numeric)
slide to create the following simple test L pree el
for zip code. The steps are: return talse;

Edit an existing Iibrary erveessessessessessesseseessessersersesessaessertersertessaessessersersersesanesnensensenes ;
Copy/Paste an existing function

Modify the function name and parameter

Use Content Assist to add new business logic

Save and Generate

v Vv Vv Vv Vv

Note: In this workshop you will create this simple business logic function inside of an existing
library. But the same process and simple EGL programming model will be used (as you'll see
in the next Unit on the EGL Language) to:

» Create a service or Web Service
» Consume (call a service or Web Service)
« Call an external program:

» Mainframe COBOL or RPG

» Java or C++ class
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Adding Custom EGL to the Data Access Wizard’s Generated Code

= Throughout the course (and especially in your production projects) you will add lots of
custom EGL to the library code generated by the data access application wizard.

= You ma% be asking yourself: “What if my database schema changes and | have to re-
import the database?”

= Rest assured, there is a way to re-import part or all of your database schema
definitions without losing any custom defined code work you’ve done.

» Scroll to the bottom of any of the generated EGL files.
» You should see some commented text
= Notice an area of comments which indicate that you should: “Add additional code here”

SYBEGIN custom Source definitions
—_— /TODO: Add additional code here
SAEND custorm source definitions

» Add all of your custom code at this location between: /BEGIN — and — //END
//BEGIN custom function definitions

...your new custom EGL code and functions go here...

//END custom function definitions

Save and close your data definitions file

» By doing this, you can re-import your entire database or that specific table and not have to
worry about losing your custom EGL functions.  sx«Notes
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»| Copy and Paste a Function

From Project Explorer,
1. Open CustomerLib.egl

2. Scroll down to near the end, and find the
function named: isValid

3. Select the entire function (the three lines

shown) /

» Copy (Ctrl/C)

....... and Paste (Ctrl/V) as shown here =

i
* Thiz function returns true 1if the supplied record
¥ Customize Co supply wvalidation rules as needed.

* izVWalid() is called prior to updating or inserting
i <= Undo Typing Chrl+2
//BEGIN IsValid

d. .- Dele

lid(tes

Show In AlE+ShifE+w »
Zuk ZhrlH-
.' //BEGIN custom function m
JiTODO: Add additional o Paste Chel+Y
A/END custom function de Select all Chrl+4
d
e Shift Right
Shift Left
(_ | 1= I

AABEGIN custom source definitions
AATODO: Add additional code here

f Function IsValiditestPBEecord Custoner) returns( boolean ):

return({ true ]:
Below: //ToD0: Add additional code here <2 1 NSRRI
SPEND custom source definitions
Above the final end statement in the file "

» This will duplicate the function in the

library — in the area where you can add o

custom functions (which won’t be over- T =
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P)| Use Content Assist to Modify an EGL Function - 1 of 2

& You will use the EGL Editor’s “Content Assist” to modify the function by following these

steps. Note that Content Assist is an “intelligent editor” — it allows you to select some
value that makes sense to code within the context of EGL business logic.

return| true );
end

5. Enter a new line
» Type the word: if

u Immediately press CtrI+Spacebar Function zipTest(zip string) ret
. . if
— Select ifelse-if else statement 2> =

re ff
enid if - if statement

iFelse - if else stakement

» This will create a templated if statement = i ior
» The selected [SRIERERIA Means that Content Assist |; / EGL statements
is still active (press Ctrl/Spacebar, select a variable name) : else

A4 EGL statements

And of course you can simply edit/type at will
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PPl Use Content Assist to Modify an EGL Function - 2 of 2

6. Using Content Assist or just plain old editing/typing, complete,
save and generate the function as shown below.

...............................................................................................

§Fu.m:!tiun zipTest (zip string) returns|( boolean ] - m -
§ if (zip i= numeric) g 6 Fl“lShed Functlon

return (true) ;
else
return (false) !

3
...............................................................................................

To save and generate:

» Ctrl/S saves and validates your EGL statements
= Note — if you make any typos, small red x’s will appear in your source next to
the line in question.

— Mouse-over the red-x’s to see a detailed explanation of the problem. Correct it.
Press Citrl/S again, and continue.

» Ctrl/G generates Java (assuming that the EGL parser found no syntax
errors when you pressed Ctrl/S)
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Topic Summary

= Now that you have completed this topic, you should have:

» Coded EGL Business logic by;
= Editing an existing Library function
= Duplicating a function, and using it as the basis for new business logic

= (Using Content Assist) created a new logic function that tests a field for all numeric
values, and returned a true/false

» Saved and Generated Java
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» 1. Create the allcustomers2.jsp page

Okay, that was easy © Time to try our first dynamic content web page.

1a. From the Site Map, Double-Click allcustomers2 l

© New Web Page

1b. Add the .jsp extension to the page name: web Page
- Select a name, location, and kemplate for a new web page.
allcustomers2.]Sp

1c. Click Finish Folder |'££5[J¢;L}M;£Lén'{ent
Template: Presview:

= et Tetes =
== My Templates

Pt e 11 lan b

theme/B-01_blue, htpl
= Sample Templates

B *Mavigation - EGLWeb M allcustomers2.jsp X

allcustomers2,jsp - B-01_blue

— Ei_l:ll_tllue.htpl

<8 Place your page content here. Template Details: Design-time page template "theme/B-01_hlue,htpl
Cmenu ;

: : ¥ Link page to templat

- allcustomers2 g % ink page ta template

. updatecustomer? '

- allarders .,

i atanrrar
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» 2. Add text, graphics or EGL variables — 1 of 3

We won’t add much in the way of graphics to allcustomers2...

2a. Modify the default page header. Add some new text and a few | 5Lt or Al !UStDmerS‘”;

C menu

line breaks  alleustenrersz” " __"1]
: iy

—

R B R Tt Tt Lr L, | epoeccccccccccccccccccccccce

2b. From the Palette, Expand the EGL drawer
Left-Click (select) Drag & Drop New Variable onto the page

rmEnU. jsp *allcustorners2.jsp &a = O || f2 snippets | 27 Palette 53
omers2 * - tpl:put ™ Standard * | [2HTML Tags
(= 15 Tags

(B Eal

k| M Wariable

A Service

- ’ " '
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MW 2. Add EGL variables — 2 of 3

2d. The Create a New EGL Data [ Xerorl Erae Wi en et
Variable wizard allows you to select | rreview
the type Of Va”able to add to your customerdrray Customer[0] {maxSize=100};
page, and customize its use.

. . —AON0006000000000000 -
SpGley the fO”OWlng Tvpe Selection Record Type Arraw Properties
() Primitive Selection List : [ array
_ODataitem ¢ Size
@ Record @Recnrd @Custumer (eglderbyr 7. data/Customer . e 100 :
@CustamerSearch (eglderbyr? . daka)Cust o maximum array length 2
@CustnmerTemp (jsfhandlers/allcustomer: | TTrTTnmm s maeas
M Array — Size 100 ol Ttem (eglderbyr 7. datayTeem. eql)
. . . . . @ItemSearch reqlderbywr7.data/Tem. egl)
(Note the size specification will be used during SQL . P =
g ) @Llstﬁpeclﬂcatlnn (eqglderbyr 7 i ConkrolSke
generation to halt cursor fetching after 100 rows) p: 3
Enter the name of the Figld:
D -
Name the field: customerArray oy [%_:
¥ou can add data contraols to your page ko display the contents of an EGL element:
Add controls bo display the EGL element on the Web page
CIICk OK (04 l [ Cancel
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MW 2. Add EGL variables — 3 of 3

2e. The Configure Data Controls wizard L ALGEESETI]
allows you to select input vs. output
controls for your data, as well as

which columns of a record to display.

Configure Data Controls

Specify the columns to display and how to display them

Data contral ko create: | Mulbi-Column Data Table {one table row per daka entry) "
Specify the following
Create conkrols for:
® Displaying an existing record (read-only) | © Dislaving an existing record (read-orly)
{3 Updaking an existing recard

{:} Creating a new record

Columns to display:

For Columns to display:
Click None — to uncheck all

Colurmn Mame Label Contral Type L
. P . CuskomerId {nk) CuskomerId Cukput Field -
Then CheCk IndIVIdua”y- FirskMame {skring) FirstMarme Cukput Field -
™ CustomerlD LaskMame {string) LaskMame Cukput Field -
. [] Passward i{string) Password Cukput Figld >
@ Firstame | | Fehone (2 e omcred 8@
M LastName
Izl Phone [I"-.Iu:une] [Optiuns... ]
Click Finish @ Finiish l [ Cancel
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» 2. Finished — Adding EGL Variables

¢~ S0, by adding EGL variables to a
web page, Page Designer creates
default labels and JSF Components
on the page.

In this case, it created a JSF dataTable
which will display your customer
rows through an EGL array, once
the rows have been accessed from
the database.

To do that, we’ll call one of the Data
Access functions you just imported,
using the EGL Data Access wizard.

To do that, we’ll need to edit our EGL
JSFHandler for this page.

M Right-click over the page, and select:

Edit Page Code

List of All Custormers,
o
(" | Custornerd™ || Firstharme®™ || Lasthame™ | Phone™
JSF <
dataTable Custornerd}™ | Firsthlarme}® | Lasthlame}®® | (Fhone} ™
“~

Ast of All Customers,

Customerld ™

¥ Delete

Save

Customerld)®  Insert
1P

Table
A7 Tnsert Link, ..

Page Properties, ..

| Skyle

Embedded Document

qn | Source | Preview ) Properties

roperties 50 Qf [ Edit Events
B2 Edit Page Code

sy
=]

v _E monoan Sereer

Chrl+

Chrl+alk+Enter
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» 3. Add EGL Business and Back-End Logic - 1 of 2

JIalicl il WS L lIIsEL S4 LYpC UJlll3ndleLr

{onConstructionFunction = onconstruction,

Recall thatin a previous step, we imported fesources onPrerenderFunction = onPrerender,
from the database, which included Records and T vapiCnetamerod 2R,
Database Access Functions. It's time to put those to
use — by coding with the help of Content Assist. viewRoot UIViewRoot;

Ccustomerlirray Ccustower[0] {max3ize=100};
3a. Enter a new line in the onConstruction () function // Function Declarations

function onConstruction()
3b. Type: cust and press Ctrl+Spacebar Fust

end Customer - eglderbyr 7, data {record)

function customerirray Cuskomer[] {array wariable)

CuskomerId - eglderbeyr 7, primitivetypes  data (dataltem)
Custarnerlib - eglderbrr?, access (library)
CustomerJagrch - eglderbyr? data (record)
CustomerTemp - jsfthandlers (record)

end

3c. Select CustomerLib — eglderbyr7.access (library)  ena
This will add the library name at your cursor focus point

3d. Next, type a period after CustomerLib. I
and press Ctrl+Spacebar |
function DnCDn.s.T.:.r.uctiDni]
3e. Select GetCustomerListAll (customerArray...) CustomerLib.
end °* ! addCustomerinewRecord Customer, status SkatusRe

AddCustomerList{newRecordList Customer[], skakus 5
DeleteCustomerideletionfecord Custaomer, stakus Ska
DeleteCuskomerList{customerList Customer[], status =
Exists{Customerld int) - boolean

GetCustomet|searchRecord Cusktomer, skakus Statusk
GetCustomerList(listSpec ListSpecification, liskOuk Cusl

|
This will add the complete CustomerLib call —minus v .
the end|ng Sem| Colon Wh|Ch you ShOUId type 9 CuztomerLib.GetCustomerlizsthll (customerArray, status-]
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» 3. Add EGL Business and Back-End Logic - 2 of 2

W Finish coding the JSFHandler for this page, rackage jsthandlers:
by adding an EGL variable for the status import eglderbyr?.StatusRec:l]

record, as shown in this screen capture

handler allcustomersZ type J3FHandler{onConstructionFunction = ol

* k%% IMPORTANT *kkx wiewRoot UIViewRoot;

CcustomeriArray Customer [0] {wax3ize = 100} ;

Do not just type. ®

function onConstructioni)

Use Content ASSiSt —as mUCh as pOSSible' CustomerlLib.GetCustomerlistill (customerirray, status):
. . . . d

By doing so, the tooling will automatically add -

the necessary import statements for you function onPrerender ()

(and it will be SOOO much easier © and you end

will make so many fewer typos) end Finished JSFHandler for allcustomers2

(note code has also been formatted)

W Press Ctrl+Shift+F to format your
code as shown in the screen capture

» Press Ctrl/S when you are done — and fix any syntax errors (which will display as red
Ianction onConstruaction()

CirCular X,S in the editOI‘ bOl‘der) |@.® CustomerLib.GetChtomerListill |

ard

Note that you can mouse-over the Red X-s to obtain additional syntax-related assistance
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menu

» 4. Run the page on the server

— w E — %
. ) Updatacustoier?
Time to test out what we’ve done! : alorers
. . . . Updatearder
4a. (From Project Explorer) Right-click over p
menu.jsp and select: Run As > Run on
Server...
Save all files when prompted.
; Welcome to the Customers and Orders System
menu List of All Customers
4b. Click the menu link to allcustomers2 aiicustomers2 |
updatecustomer2 Customerld | FirstName | LastMame | Phone
allorders 1 Fred Filibuster  (201) 652-3456
W e 2 Andrew Lundguist  (221) 245-5467
3 Erice Kingman (261) 898-42343
4 Francine  Lisbowitz  (414) 923-2324
5 Ornette Coleman (918) 132-4279
G Ellen Springsteen (712) 469-5533
7 Martin St Louis (G70) 250-5689
So — now that we’ve done one ‘“list page”, 8 Sergey  Sharov (413) 452-1983
, . ; 9 MNaomi Hudalk (860) 742-0932
let’'s consolidate what we’ve learned, and 10 Abigal  Freeman  (201) 6522058
create allorders. 11 Raobin Cassidy (212) 652-4458
12 Jennifer Muce (201 652-0508
_ 13 Doug Potter (860) 445-2343
Close all of the pages in the Content Area 14 Francis ~ Giordano  (908) 578-2323
15 Fred Filibuster  (201) 652-3456

except for: Navigation — EGLWeb

allcustomers?  allorders
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»| Create updatecustomer2.jsp

= From the Site Map:

Double-Click updatecustomer2

. ) Web Page
" Add the Jsp eXtenSIOn to the page Select a name, location, and kemplate For a new web page.
name:
updatecustomerl. jsp File Mame:| L[:aé.i.;éu's't;}n'e}'z};.;";

Folder: | ,I'EGLWEEI,I'WEEICDI‘IIZIJA‘E

Template: Presview:

= el Templtes <
=== My Templates

Bty gt 1l e

= (Click Finish

= Sample Templates

» Modify the default heading text, and add T
a few line breaks.

B-01_blue.hkpl

Template Details:  Design-time page template “theme/B-01_blue, htpl*

<8 : Update Customer Record,: [F]Lirk page to template

©menu

. allcustornersz2
. updatecustomer2

600000000
+E
00000000

- allarddares
ooooooooooooooooooooooooo

W From the Palette Drag & Drop an EGL
Variable on the page
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W 2. Add EGL Variables - 2 of 3

2d. From the Create a New EGL Data

Variable wizard specify the
following (actually, you can
probably just take all of the
defaults!)

® Record

O Un-check Array

Name the field: customer

Leave checked:
M Add controls to display the ...

Click OK

Presiew

customer Customet;

Type Selection Record Type i..|:'.rra~:.fF‘r-:q:uarlznas ..... :

) Primitive Selection Lisk [ array

() Dakaitem | |5 size

{®)Record ; T ———, | | :

........... @Custumerﬁearch l{eglderbyr? data,l'Custn maximum array length =
@CustnmerTemp (jsfhandlers/allcustomer, | Teeessssmmsssssssneat

@Item (eqlderbeyr? . datajTrem. eql)
@Itemﬁearch (eqlderbyr?.data/Item.eql)

@Listﬁpeciﬁcatinn (eqlderbeyer? ) ConkrolStr,
£ »

Enter the name of the Field:
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W 2. Add EGL Variables — 3 of 3

2e. From Configure Data Controls

...specify the following | configure Data Controls
Specify the columns to display and how ko display them Q _'\'I:m
=
Create conkrols For:
. o o Pblzdnaan AR na P read-only)
® Updating an existing record | :©uedstng an existing record ;
‘ﬂl}\géa'tﬂwﬁ LR P
Fields to display:
.Field Mame Label Conkral Type -~
. : CuskormerId (ink) CuskomerId: Input Field ¥ [
DlSplay a" Of the c°|umns | [#] FirstMame (string) FirstMarne: Input Field b
[ LastMame (string) LaskMarne: Iriput Field e
(Leave them a” [Zl CheCked) Password (string) Passwiord: Input Field h
| Phione (string) Phione; Input Field hd
[ Emailaddress (string) Emaildddress: Input Field -
[ Skreet (shring) Skreet: Input Figld ¥
: Apartment {skring) Apartrent: Input Field h [
. . [ i i it Field | B
= Click Options... and ensure that at | < Sy Anput fi v 2
least one M Submit Button is [aore | [options... |
checked
= Click Finish | © Frisn ] [ Cance
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» 2. Finished — Adding EGL Variables

& The default Page Design layout for a _
non-array record is a vertically spaced,

form with submit buttons. e Update Customer Record,

allcustorners? ‘J
_ pdatecustomer2 1o e
» Let's add the code to make this page allorders Firstame " Trrstaner
run. e LastName: - flositone)
FPassword: {{Password} ah
s I'{'F?Hl:'.%é)} ................. =

P Right-click over the page, and select: R
Edit Page Code " 3

Updatecustomer?
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» 3. Add EGL Business and Back-End Logic

As shown in the finished JSFHandler code below, use Content Assist***

(Ctrl/Spacebar) to add the following (save with Ctrl/S when done): o Z:jg;igicgzzijijzgiid ot
1. A JSFHandler property: cancelOnPageTransition = yes customer .
2. A status record variable declaration o e v oy o2
3. Modify the onConstruction function, add the parameter: ecid as shown Ssoneria) sgoerbydia
4. Add an assignment statement, to hard-codes c¢id’s value to 1 c::;ies':t
5. And an assignment statement to customer. customerID variable
6. Finally, a call to the CustomerLib.GetCustomer (..) function

package Jsfhandlers:
import eglderbyr?.3tatusRec:[]

handler updatecustomer:s: type J3FHandler
{onConstructionFunction = onconstruction,
onPrerenderFunction = onPrerender,
view = "updatecustomerZ.]jsp”,
I viewRootVWar = wviewRoot,cancelOnPageTransition = yes}

wviewRoot UIViewRoot:
customer Customer:
—l- status StatusBec:

KL LE T EE PR TR

function onConstructiohicid int]§
cid =1; € The cid = 1; statementis here so that we can test the page standalone
customer.customerId = cid:
CustomerLib. GetCustomer (customwmer, sStatus) ;

end

function onPrerender ()

end

end

**% Note: By using Content Assist the import statements needed for all this code will automatically be added to your JSFHandler!
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» 4. Run the Page on the Server

Time to test out what we’ve done!

(From Project Explorer)

menu
allcustomers2

Update Customer Record

4 nght'C“Ck over updatecustomer2.jsp and updatecustomer2 ustomerld: 1
» Select: Run As > Run on Server... allorders Firsthame: Frad
updateorder
LastMame: Filibuster
Fassword: b1
Fhone: (201)652-3456

But we have a lot of work left to do to this page.

EmailAddress:

f_filiBusti@uas.com

» Cosmetic page design enhancements Street 14 Maple Avenue
» EGL (business logic) and more. Apartment. 1A
ity YWake Forest
’ : State: SN
Let’s get started by commenting out the statement
in the JSFHandler that hard-codes cid to a 1 value Postalcode: 07542
Directions: Past the giant rack, turn |
»w Right-Click over updatecustomer2.jsp v [Doiee )

and select Edit Page Code

Updatecustomer?

» Type two forward slashes in front of the //cid = 1; statement
function onConstruction(cid int)
cid =1;
rm=stomer . Cunstomer Tl = maid:

- /Y
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5. Refine the U.l. Model

&~ S0 we’re ready now after doing the basic Web Site and EGL work to
make the pages ready to show our users.

= Here’s what'’s left to be done — you will:
» Add a link from the list to the detail pages
» Refine the U.l. for all of the dynamic content pages
» Refine the business logic for the update page
= Add update and delete data access functions
= Add business logic calls to our data validation routine

= Sounds like a lot, but it’s all straightforward work. We'll start by adding a
link from allcustomers2 to updatecustomer2, to pass a clicked row
value from the list to the detail page, so users can select the row they
want to update.

© 2009 IBM Corporation 102



»| Adding a Dynamic Content Hyperlink — 1 of 3

(From Project Explorer)

1. Double-Click the allcustomers2.jsp

(From the Palette)
2. Open the Enhanced Faces Components drawer

La wWeED JiLe pdyigden |

[LI;,'- EGLSource

:5 Java Resources

&, Web Diagram

B Javascript Support

ﬁg Security Editor

4= WebContent

#- (= cam

[+~ images

= META-INF

5= theme

- 5= WEE-INF
allcustarmers jsp

allcustomersz2. jsp
allorders,isp
calculator, jsp
hellal.jsp
hellaz.jsp
hella3.jsp

P

1-

<8
ey

allcustomers2
updatecustomer?
allorders
Updateorder

# | ist of All Customers.

o

Customnerld

Firsthame

LastName

Fhons

{C,'aJsz;‘z=:::=r?'|>:zer§(:i]-ﬁb'E

iFirsthame] .

iLastMame] .

{Fhonet .

(£ Enhanced Faces Components

[[=| Data Tahle
fa- Daka Tree

[=l|Panel - Group Box
Panel - Form Box
[~ Panel - Section
[&&l Panel - Dialog
[T]Panels - Tabbed
(=] Button - Command
5}5’ Link. - Request

A Link

5] Menu Bar

=] Action Bar

© 2009 IBM Corporation

103



» Adding a Dynamic Content Hyperlink — 2 of 3

(From Page Designer)
1. (Left) Single-Click the lastName control in the middle of the column

rFalncis (=N NN

i :'"h [= Button - Command
(From the Pale tte) 5 Ll...:i!::'.l i Heh i {PhOrIE} e 5%; Link - Request
2. Double-Click a Link component gk 2.
| g re:lilnszrrt a link that may have a
Tl target

(From Configure URL)
3. Enter the URL: updatecustomer2.faces

o) Configure URL E|

LRL: 3. | updatecustomer2. faces

Label {Opkional):

C“Ck OK I C]EE H Cancel
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»| Adding a Dynamic Content Hyperlink — 3 of 3

With the link iz next to LastName

selected:

AR

Open the Properties View

Click the — Parameter tab

Click: Add Parameter

Name the new Parameter: c¢id

Tab into then click the Page Data icon

From Select Page Data Object, expand
customerArray and select:
CustomerId -

& Select Page Data Object

Data Object |Expressinn String Resource

CustomerlId

Diata Objects:

% applicationScope
A requestScope
. secgionscope
== Data

= &g cuskarerarray - Cuskamer]]

7. Click OK

Apartment - Aparkrent
Ciky - Ciky

Ed - CustomerId 6.
iona- Direckions
Frnailaddreez= - Frraildddrez=

2.

<

I lstormer o

Design | Source | Preview

=
kable

Ebods:

kr

kd
hi:dakaTableEx
bz colurnnE

b ioukpukLinkE

Pararneter

4- cid

i rstName}ﬂ"’;

1 - MQuickEdit Servers  Console | Problems | EGL Generation Results

i

Add the parameters that are passed with the link:

Mame Yalue

&dd the parameters that are passed with the link;

Mame

| Add Parameter ]3.
gy
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W Test Your Work

(From Project Explorer)

= Right-Click over menu.jsp
and select Run As > Run on Server...

menu

allcustomeriz
updatecust 2

allorders
=  From the menu, launch allcustomers2
= From allcustomers2, select (click) a hyper-linked
LastName
Welcome to the Customers and Orders System _
menu Update Customer Record
allcustomers2
updatecustomer? Customerld: 2
M allorders Firsthame: Andrew
updateorder
Lastiame: Lundouist
menu List of All Customers Phone: (221) 545-5467
allcustomers2 : EmailAddress: | alundy@ynot.com
updatecustomer? Customerld | Firsthame | LastName | Phone Street o Grard Bodloverd
lordars 1 Fred Filbuster  (201) 652-3456 rect renci Boulevar
updatearder 2 Andrewvy Lundqui%' Hrg R e mer o Apartment: 2B
3 Erice Kingma (261) 898-42343 City: Faleigh
4 Francine  Liebowitz  {414) 923-2324 State: oT
5 Ornette Coleman (518) 132-4279 Bostalcode 29762
6 Ellen Springsteen (712) 469-5533 ostalcods.
7 Martin St Louis (70} 250-5689 Directions: Fast Grand Boulevard. 1
g Sergey Sharoy (4131 452-1983
0 [Py sl [9EM 7AD QA7 | Submit | | Delete |
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5. Refine the U.l. Model - for Dynamic Content Pages

& S0, there’s still some left to be done to our prototype. We need to add more EGL

business and data access logic, and we need to make the pages look a little nicer.
We’'ll start by doing the latter, and then wrap back around on the EGL coding for
database updates.

= List pages (allcustomers2 and allorders):
» Add a border to the data tables on both pages.
» Add alternate row colors

» Add paging (for allcustomers2)
= Add inline update form for allcustomers2 (OPTIONAL)

» Row Categorization (for allorders)

= For the detail page we’ll:
» Make the key field read-only (so users aren’t tempted to update it)
» Change the color of the cells and text justification
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»| Adding a Border to a dataTable

(From Project Explorer: Open allcustomers2.jsp into the Content Area)
1. Click a column header, and press the up arrow key on your PC 4

List of All Customers,,

d

 This selects the entire dataTable and makes its properties available 4 ICistormend | [ Firsty
updatecustomer? ¥ — — — —
allarders Custornerld™ || Firsthlame™ | LastName™ | Phone™
updateorder
[Customerd)™ | Firsthlamel™ | [#iLastNarme) ™ iPhone ™
2. Click the Properties View tab
. . <
3' SpeCIfy Border' 2 Design | Source | Preview
2. muickEdit Servers | Console | Problems | EGL Generation Resulks
table Id: “ableEx1 Width: | Columns: F
tbody — Label
- Yalue: | #4{allcustomers?, cuskame Eh:.rd.;r: 5 (oixels) C_ust-:umerld
kd % FirstMame
- Skvle: Props: Padding: | 2 (pixels) Ilaisl;tlfl'-.leame
b scripbCollectar Classes: | dataTableEx _ _
: |
Run the page on the server, to = cdataTableb Spacing: [0 | (pixels)
see the effect of adding a border. |  isplaysptions | Backaround cobr: ]
B s arkinns
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»| Adding Alternate Row Colors to a JSF dataTable

(Still editing allcustomers2.jsp into the Content Area — with the entire dataTable selected)

1. (From Properties) click the - Display options tab

2. Delete the content of Column classes:

Run the page to see results of
alternate row colors

© updatecustomer2
o allorders
. updateorder

<
Design | Source | Preview

Custornerld™ | Firsthame™ | LastMName™ | Phone™

mguickEdit Seryvers | Console | Problems | EGL Generation Results

[Customerld)®® | FFirsthame] ™ | |#LastNamel® (Phone) e

&
kr

kd

table

thady

kr

kd
hix:dataTableEx

1 - Display options

Table content style: 2. Paging: Rows pet page:
Calurmnn classes: Add a web style pager

Row dasses: | 551, rowClasse [ EFIE ] add a goto pager
Header class: | headerClass % R b ) Add 2 deluxe pager
Add a simple pager
Add page informakion

Fooker class: fFooterClass
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(OPTIONAL WORKSHOP) Add an Inline Form to a dataTable

You might wish to allow users to actually update a customer record “inline” from the .JSP page’s
dataTable (as shown below). This useful web U.l. technique is not that hard to achieve using
EGL and JSF technology. However:

1. Please consider this workshop optional — finish it only if you’re ahead of schedule in the class (it will
take 10 — 15 minutes)

2. If you do complete this workshop, your allcustomers2 functionality will not match the course’s (as we are
not expecting everyone to accomplish this). And screen-captures might not match, etc.

3. You can always back out your changes by pressing Ctrl/Z — repeatedly

B " | http:flacaihost:B080/EGLWeb/allcustomers2 faces
allcustomers2 LastName Lishowitz |
updatecustormer2 Cus Password |aNewF’Wd | =
jgzngmer ' |Phone (414) 923-2324 |652-3496
2 |Emailaddress |newEmai|@aHDuse.edl| 545-5467
3 |Street 1234 Poliics Circle || 898-4343
edit) 4 | Apartment |NewApartment |923—2324
edit]|5 [ City Sacramento [132-4279
| State Y |
[ updateo{Postalcode 12309 |
Directions New directions |
allcustormers?  allorders
[Save ] [ cancel ] F ?T;;?____?
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» (OPTIONAL Lab) Adding an Inline Form to a dataTable — 1 of 6

handler allcustomers: type JElPHandler

(If nOt St”l y Open a||CUStOmer82.eg| |n the {onConstructionFunction = onConstruction,
Conten‘t Area) onPrerenderFunction = onPrerender,
wiew = fgallcoustomerzZ.Jjsp™,

viewRootVar = wviewRoot}

viewRoot UIViewRoot:
CcustomeriArray Customer[0] ;
status ItatusBec;

A Function Declarations
function onConstruction()
CustomerLib.GetCustomerlizstil]l (customerAirray, statuz) ;

end
= Using Content Assist, add the following function onPrerender ()
updateOrders() function and call to your ™
CUStomerleUpdateCUSTOmerLISt() function updatedrders()
fUnCTIOn (WhICh was created by the Data Access CustomerLib.UpdateCustomwerList (customerlrray, status) ;
Wizard) y, end

end

= Save (Ctrl/S) your coding — and
remove any/all syntax errors in your
EGL source.
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updatecustomer?

» (OPTIONAL Lab) Adding an Inline Form | .. »

Column;

Custornerld™” | FirstName™ || LastNarm
to a dataTable - 2 of 6 UBASOTIST | i |

(Return to work on allcustomers2.jsp in the
Content Area)

. . g abe . abe ||
1. Click a column header in the dataTable, 1| [(Customerid} | {FirstName} | #{l astNar

and press the up arrow key on your PC: f
- this selects the entire dataTable

i
Design | Source | Preview ;
(From PI‘O pe I’tles / = ROW aCtIOnS) muick Edit | Servers | Console | Problems | EGL Generation Results
‘/@ Click: Add an edit column that brings up a sy Actions that execute when you click on a row in the table:
form for in-place Edltlng of row content tahle Add an action that's performed when a row is clicked
thody [ addy. | Add an edit column that brings up a Farm For
i k in-place editing of row conkent
kd
kable
thody
kr
kd
kpl:put

This will add a new column to the left of your | fxseriptcaliector
dataTable, with an area in which you can drag | ™™™
and drop an EGL variable hic:dataT ablefx

Display options
— Row actions

Skvles
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» (OPTIONAL Lab) Adding an Inline Form to a dataTable — 3 of 6

(From Page Data) Select (left-click and hold), then Drag and Drop customerArray into the
inline form area - this will bring up Configure Data Controls

allorders

Updateorder

1 Crop here toinsert new
controls For “customerareay” 0 Drop ltems

w58 10 populate é‘:
ihis regr custormerdrray b 00s
‘ =] |

o Ou... (st (Th..| = OE&

-
= % B

allcustomers2

allorders

|
= Scripting Yariables Diesign | Source | Preview
= J5F Handl
& andier E Properties &2 Cuick Edit | Servers | Console | Problems | EGL Gern
== Data
M - jstomerirray - Customer
[+ ﬁu cuskomersrray - Customer[] bty 1d: | jspPanel]
i shakus - SkakusRe:

%.; viewR ook - UIviewRoaok EES
[= Actions thody
2 Services br
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» (OPTIONAL Lab) Adding an Inline Form to a dataTable — 4 of 6

(From Conligure Data Contrls

Configure Data Controls —
-, 1
Specify the columns ko display and how ko display them %_\ —

=]
Create controls For;
(" Displaving an existing record (read-only)
Specify: © Updating an existing record () Updating an existing record

{:} Creating a new record

Fields to display:

Field Marne Label Control Type

Un-check: CustomerId [ ] CustamerId {ink) CustarnerId Imput Field ¥

. k irstMarme [skring) Firstharme Input Figld ¥
Lastrarme (string) Lasthame Input Figld ¥
Passwiord (string) Passwiord Input Field >
Phone {string) Phone Input field >
Emailadddress (string) Emailaddress Input Field >
Skreet (string) Shreet Input Figld b
Apartment {skring) Apartment Input Figld ¥
ity (string) ity Input Field hud
Skate (skring) Skate Input Field >
Postalcode (string) Postalcode Input Field >
Directions {string) Directions Input Field >
[Nu:une] [Optinns...]

Click: Finish | @ piish__J | Cancel
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» (OPTIONAL Lab) Adding an Inline Form to a dataTable — 5 of 6

(From Page Data)

Select (left-click and hold) then Drag and Drop the updateOrders() onto the page

» This will create a submit button control

function

0T Ou... |5t...

- “bound” to the updateOrders() EGL

Th.. — &

= Seripking Variables

1 Crop here to insert new
contrals For "updateCrders"

== 15F Handler
== Data
[+ "wg?.;. cuskomerarray - Cuskomer[]
[+ %ﬂ. skakus - SkatusRec

"wgé.;. viewR.ook - UIviewRook
== actions
// updatedrdersi)

==

Desu;n Source | Preview

E Properties B2 CQuick Edit | Servers | Console | Problems | EGL Genera
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» (OPTIONAL Lab) Adding an Inline Form to a dataTable — 6 of 6

|

htkp: fflocalhost: 3080 /EGLYWeb) allcustomersz2 Faces

Firsthame Francince

menu
allcustomers2
updatecustomer?
allorders
updatearder

allcustomers?

All Custorm

Lasthame

Cus FPasswiord

1 FPhone
2 EmailAddress
3 |Street
adit| 4 |Apartment
adit[15 City

| State

update

allorders

Postalcode

Directions

[ save ] I cancel I

Liebowitz
arewP'd
(414) 923-2324

newEmaili@aHouse.ed

1234 FPaolitics Circle

Mew Apartrment
sactamento
My

12304

Mew directions

=
652-3456

045-2467
598-4343
923-2324
132-4279

F

Run the page on the server
Click a row’s edit button

Modify some data value(s) in the

form, and click the save button to
test this new functionality.

» Try making changes to one of the
rows and clicking cancel as well.

Click the updateOrders button —
to save your edits to the database

Re-run allcustomers2
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»| Adding Alternate Row Colors to a JSF dataTable

(Still working on allcustomers2.jsp into the Content Area — with the entire dataTable selected)

1. (From Properties) click the - Display options tab

2. Delete the content of Column classes:

Run the page to see results of
alternate row colors

© updatecustomer2
o allorders
. updateorder

<
Design | Source | Preview

Custornerld™ | Firsthame™ | LastMName™ | Phone™

mguickEdit Seryvers | Console | Problems | EGL Generation Results

[Customerld)®® | FFirsthame] ™ | |#LastNamel® (Phone) e

&
kr

kd

table

thady

kr

kd
hix:dataTableEx

1 - Display options

Table content style: 2. Paging: Rows pet page:
Calurmnn classes: Add a web style pager

Row dasses: | 551, rowClasse [ EFGs ] Add & goko pager
Header class: | headerClass % R b ) Add 2 deluxe pager
Add a simple pager
Add page informakion

Fooker class: fFooterClass
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EGL and Remote Programs

Sub-Topics:

= EGL Calls to Remote Programs (Overview)

= Calling Java (terms and concepts)

= (Calling Java using ExternalType
= (Calling Java using Javalib
= (Calling COBOL Programs

= Calling RPG Programs
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Calling RPG Programs

= |n this section you will learn how to call RPG programs
running on an IBM iSeries server.

= This lab requires you to have open Internet (TCP/IP) access
on your PC

* You will be calling (up to) four RPG transactions,
running in an IBM System i in Dallas/Fort Worth.

» The steps you learn here should be generalize-able to your
specific shop’s enablement

EGL Logic Part
call program...

Here’s what you’ll do:
1. Add the iSeries JT400 toolkit to your project
2. (For each RPG program to call) Add to the EGL Linkage Part for your Build File
3. Create the business logic to call the RPG Program

First we will start with an overview of the system architecture and process =
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Calling RPG Programs - Overview

Calling a RPG, COBOL, CL, or other program on the System i from EGL is as simple as coding:

call “myProgram”. . (parml, parmN).;

» The facility is however extremely flexible and supports the many options that may be required
to support many possible options and configurations. EGL takes into account the many
possible runtime options that may affect how you run your jobs and call the RPG programs.

= EGL uses the System i Toolbox for Java™ to call programs on the System i. The toolbox in
turn uses the i5/0S Remote Command server that is a part of the i5/0S Host Servers.

= The Remote Command server in i5/0S consists of a server daemon program that listens for
TCP/IP requests from “clients”. This program is QZRCSRVSD which runs in the QSYSWRK
sub-system.

=  When the Remote Command Server starts, it starts a number of “worker” jobs that process
requests in the QUSRSYS sub-system. These jobs are all named QZRCSRVS.

= The next slide describes this process in graphical and technical (in the Notes section) detail
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Calling RPG Programs - Steps (Revisited)

¢~ Here’s what you'll do:

» One time step

[=-[= wehConkent
[= META-INF
[== theme
= [ WEE-INF
[= classes
== lib
|=| Fda7?.jar
icudi_3_4_1.jar

- Add the iSeries JT400 toolkit to your project and Java Build Path ._. jsf-ibm. jar

» Once for each RPG program to call

- Add an EGL Linkage Part for the program

» For each call

Page Data EE Cutline &8

= 98] EGLWeb.elhld
‘= Import Cpen

Tl EGLWe )
@ resfss
# Yalidate File

'ﬁ,i': extern

- Code the business logic to call the RPG Program, from an EGL “client” logic part:

- Service

- JSFHandler
- Program

- Library
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function onConstruction()
svslib.setBemotelser ("EGL4ERPGY, "EGL4YTOU™ §:

end

Function callBPG1()

fBoenario 1.
> call "RPG1" (shiptype, shipoption, =ipcode, shipcost):

end

csRec.
csRec.
csRec.
csRec.

Call passing separate parameters

Shiptype = shipType:
ShipOption = shipOption;
zipCode = zipCode:
shipCost = shipCost:;



» Add to the JT400 Toolkit to your Project

Calling RPG programs on an iSeries box requires the JT400 toolkit in your build path.

» There are 2 ways to do this (you only need to do one of these)
1. Add the file to the build path

= Right-click over your project and select Properties

= Inthe window that pops up, select Java Build Path on the left side of the screen

= Select Add External Jars... Find the jt400.jar file on your pc, select Open, Select OK to close the

properties window.

2. Put the file in the WEB-INF->Lib folder.
= Switch to the Resource perspective fsresource
= Expand Web Content > WEB-INF - lib folder

L Properties for, EGLWeb

| kvpe filker bexk |

Info

BeanInfo Path

Builders

Cryskal Reports File Wersi
DAl Web Services Prow
EGL Build Path

EGL Default Build Descrip
1ZEE Module Dependenci

Jawva Build Path

— Drag jt400.jar into this folder

Java Build Path

[ source | = Projects | =i Libraries | P Order and Expart

1ARs and class folders on the build path:

B\ EAR Libraries

Add JARs. ..

]

B JRE Swstem Library [WebSphere wé.1 JRE]

=i Web App Libraries

[ Add External 1ARs. ..

B WebSphere Application Server wé.1 [WebSphe [

add Yariable. ..

]

[

== WebConkent
[= META-INF
[== theme
= [ WEE-INF
[= classes

== b <
|=| Fda7?.jar
= icudi_3_4_1.jar
\=| jsf-ibrn.jar
[ERit100.jar

Drag Here
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2. Create a Linkage Options Part — 1 of 3

= From Project Explorer,
Open EGLWeb.eglbld using the EGL Build Parts Editor

= From the Window menu, open an Outline View

»= From the Outline View (bottom left corner of the Workbench)
» Right-click over EGLWeb.eglbld, select Add Part...

= Select ®Linkage Options and click: Next

= Name the part: externalPrograms click: Finish

Page Diata SEE
P EGL YW eb, eglbld

! = Imports

Ta] EGLWebwel

@ resAssociati

Open

From the externalPrograms part:
= Click: Add
In the CallLink Elements:

#) Yalidate Fils g

» Name the program: CBLCLSP1 o e e
4 Type: remOtecaII ?giiersianTahle {CHSDOE?Jgg =
chgkeystore (no value set)

Enter the following properties:

chgkeystorePassword (no value set)
. tglocaki [ I ]
» conversionTable (type): CSOE037 cgport (no value sst)
. . . libraty (no value set)
4 |Ocat|0n (’[ype) els/eglc1cs location eisfealcics
[ ankral SERNER.
» luwControl (select): SERVER package (na value set)
parmFarm COMMDATA
» parmForm (select): COMMDATA freshureen (10 vehe 521
. remateind GEMERATION
» remoteBind: GENERATION remateComType CIC512C
remaotePgmType EXTERMALLYDEFIMED

serverlD (no value set)

» remoteComType (select): CICSJ2C
» remotePgmType (select): EXTERNALLYDEFINED

= Close and Save your Linkage Options — and Close/Save the Build File
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»| Add to the Build File’s Linkage Option — 1 of 2 voee pate (ST

v = | E
B E e ivveb. eqlbid |
. = O
= From Project Explorer, _ _ £ imports Pen
EGLWeb.eglbld using the EGL Build Parts Editor B”‘J EGLWebiiel
= From the Window menu, open an Outline View e aidate il
* From the Outline View (bottom left corner of the Workbench)
» Right-click over EGLWeb.eglbld, select Add Part... mwles Thumbnails
» Select ®Linkage Options and click: Next = gl EGLweb.eghbld
= Name the part: externalPrograms click: Finish = Imports
?e] EGLwWebWebBuildOptions
Ijj 2 iti
= From the externalPrograms part: 1 pe———
» (Click: Add
parnlare RPG1
kype remoteCall
alias RPGCLEF]
. ) conversionTable CSOENST
In the CallLink Elements: A (no value set)
> m rogram: 1 chgkeyStorePassword ino value set)
ame the progra
N Type remoteCaII chgLocation Eru:u va:ue setg
. ckgPaork no value set
Enter the following properties: iavalirapoer ':ET;DL ;’3'$E set)
. . ibrary
4 AllaS. RPGCLSP1 |acation iserigsd, demos,ibrm, com
» conversionTable (type): CSOEQ37 luCantrol SERVER
L. . E LP T package (no walue sek)
> lbra_ry. G (0) partnForm ino value set)
» location (type): iseriesd.demos.ibm.com refregh;tr;en éﬂ;&ﬁgﬁ
Fematenin
» remoteBind: GENERATION femﬂtiggmwpe {EKTER{‘MLWSEFINED
SEFVEL no yalde se
» remoteComType (select): JAVA400

» remotePgmType (select): EXTERNALLYDEFINED
= Close and Save your Linkage Options — and Close/Save the Build File
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» Add to the Build File’s Linkage Option - 2 of 2

= From Project Explorer, Right-Click over EGLWeb.eglbld and select: Open with Text editor
= Scroll down to the line <remoteCall pgmName=“RPG1”..

= Click your mouse at the beginning of the line (to set focus)

= Press Shift/End — to select the entire line (see reverse video line below)

» Press Ctrl/C —to copy the line

» Modify the pgmName’s and Alias’ in the new lines to:

= Enter a new line, and press Ctrl/V 3 times — to copy/paste the entire line three times -—-- s
[
RPG2 RPGCLSP2 :
|
RPG3 RPGCLSP3 *
RPG4 RPGZIPCK

= Close and save your edits

<Wln>
<Zequs systentlame="d:}
<fwinx
ssociation:
reelssociationss
celssociations name="C3VEReco
sociation filelawe="C3VERec™
<wWwin
<gequs systenllame="D:tC
<fwinx
ssociation:
reelssociationss
edptions name="externalProg
11Link =
<remoteCall pomlate="CELCL
<remoteCall pomlatne="CELCL
<remoteCall pomMName="CELCL
<remoteCall porlMNatme="CELZIP

<remoteCall popallasme="RPE1M

Paste

Shift Right
Shift: Left

[ #dd ko Snippets...

Run As
Debug As
Profile As
Yalidate
Analysis
Team
Compare With
Replace wWith
Link, Lkilities

Preferences. ..

k|12
vl

T ¥ v v v

<remoteCall pomilaune="RPFZ1" alias="RPGCLIP1"

<remoteCall pogmame="RPG2"™ alias="RPGCLIP2"

<remoteCall pomiamme="RPE3" alias="RPGCLIPS™

<remoteCall pomiamme="REF>3" alias="RPGZIPCE"
<fealllinks

7' location="eizfeglcica” luwControl="3ERVER"™ parmForm="COMMDALTL™
7' location="eizfeglcicas” luwControl="3SERVER™ parmForim="COMMDALTL™
7' location="eizfeglcics” luwControl="SERVER"™ parmForim="COMMDALTL™

" location="eisfeglcics™ luwControl="3ERVER"™ parmForw="COMMDATL"

1Takhle="C30E037" library="EGLFOT" location="iseriesd.dfw.ibm.com"



2. Replicate the Linkage Options for Additional Programs - 3 of 3

= Close and save your edits to the Linkage Options

EP EcLiweb. eglbld

rununit, propetl

ﬂ%] servicedescriph

|X| zipService,wsd
','% Jawa Resources: st
= hin

= TAwASOLFCR

MeEw r

Qpen F3

¥|* P EGL Build Parts Editor

= Copy Chri+C [5] Text Editor

= Open EGLWeb.eglbld with the EGL Build Parts Editor
= Un-check: Show only specified options

= From the linkage Option, open the drop-down list and

select: externalPrograms .. R ———
dbms DEREY
deploymentDescriptor servicedescriptorl
genbataTables YES
genDirectory CHAEGLY 7 3ample) EGLWeb EGLSource\ COBOLGEM!
genProject EGLiWWeb
genProperties GLOEAL
j2ee YES
linkage
iz I <= nalFrograms. <
resourcefssociations K
sqlDB jdbc:derby: Ci\databases\EGLDerbyR 7; create=true
=qllD jsayles
sqlJIDECDriverlass arg.apache.derby, jdbc, EmbeddedDriver
snlTMOTMAmE idhr (FGI DerbwR 7

= Close and save your Build file
= Right-click over your EGLWeb project and Generate
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3. Create a New Page to Test Your RPG Program Calls

Before creating the page you need to generate the new Build-file entries to Java
» Right-click over the \EGLSource\ folder and select Generate

Now let’s create a page that calls your COBOL programs
» Right-click over \WebContent\ and select, New > Web Page
» Name the page: callRPG.jsp
» Change the boiler-plate page heading text as shown here...

s

M|
Fill in Shiptype(1-5), ShipOption{1-5) and ZpCode - and click callRPG1, or click: callRPG2
Fill in the input fields in the array below, and click calRPG3,

M

{ _all RPG Programs From EGL

= Right-click and edit the Page Code
From inside the JSFHandler

» Select and replace all of the boiler-plate code with the code in the Notes section of this
slide

» Note that there is a lot of source code, as the four RPG programs are included as comments at the
bottom

= Details of the program calls are covered on the next slide

@
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package Jjsfhandlers:

3 EGL RPG P C " import com.ibm.egl.js£.*;
" rogram a S handler callRPG type J3FHandler {onConstructionFunction = onConstm

viewRoot UIViewRoot;

So — you can see from this example, that there //Farms to pass into EPGCLEPL and RPGIIPCK

is nothing complex whatsoever about shiptost  decimal(7,2):
calling RPG programs from EGL. This zllll?cgde_ '?“:r_f]_ - renzint
JSFHandler has several different scenarios: Saipbption  Ant =2/
) . oL shiptype int = 1:;
» Passing individual parameters to RPG statelbbr  char (2} = "NH";
» Passing a single record returntode int;
Message char (10) ;

» Passing a record that contains an array

fiFixed-length record
» Here are the record definitions (nothing csRec caleShipRecREG

; . . ffFixed-length record with a fixed length array within
new...hope you’re not disappointed © ) coRecirray caleShipirrayRecRPG:

4 Function Declarations

fiFixed Records to pass to RPG programs function onConstruction)

record calcShipRecRPG type BasicRecord sy=lib.setRemotelUser ("EGL4RPG", "EGLAYOU"™ ); //Login to ]

10 Shiptype int = 1; end
10 ShipOption int = Z;
10 ZipCode char (5] = "902107; Function callRPG1()
10 ShipCost Decimal (7,2 : ff3cenario 1. Call passing Separate parameters
end call "REF&1"™ [(shiptvpe, shipoption, =zipcode, shipocost):
c2Rec.3hiptype = shipType:
record calcShipirrayRecRPG type BasicRecord esRec.ShipOption = shipOption;
05 Ship [4]: csRec.zipCode = zipCode:
10 Shiptype int: csRec.shipCost = shipCost:
10 ShipOption  int: end
10 ZipCode char (5] ; fd8cenario 2. Call passing a fixed record
10 ShipCost Decimal (7,2); Function callRPGZ ()
end call "RPG2"™ [csRec);
end

record BPGZipCkRec type EBasicRecord

10 Stateibbrev char(2) = "NH":

10 ReturnCode int = 0O;

10 ZipCode char {5) = "90210"; —_— =
ona Press Ctrl/S (save) your JSFHandler ==&
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4. Create the Page Results

. Call RPG Frograms From EGL,
From Page Designer: y

Fill in Shiptype(1-5), ShipOption({1-5) and ZipCode - and click callRPG1, or click: callRFGZ2 ,
= From Page Data — drag €CSR@C i ine input fields in the array below, and click. calRPG3,
on to the page =

M
» Make the top three fields input ST s _
» Make ShipCost output Shiptype:  : fhetyee}
. . . Shlprtlon EI{ShipOptiDn} ke
» From options, specify no Submit ZipCode 5"?|;['z'i'|;.5;a;} --------------- —~
buttons (un-check) ShipCost | ShpCo®
= From Page Data — select all three BiError Messagest .

(callRPG1, callRPG2 and
callRPG3) functions, and drag them

. 4
onto the page, to create three submit ,|_calrest | _calrecz | calreas |,
buttons. /

You can optionally add HTML  #~ ¢
Horizontal Rule tags between the

-

controls Shiptype ™™ || ShipOption™™ || ZipCode ™ | ShipCost "
» From Page Data — drag -
csRecArray onto the page = éShip'é |
» Make the first three columns : {Shiptype} e | JiShipCption} abe | JiZinCode} abe | f[ShipCosty™ |
Input Text type -
» Make ShipCost outputText

Design | Source | Prewview
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» Run the Page — and Call RPG

» Run the page on the server.
= Enter the values shown below — and click the buttons.

» Note that callRPG2 passes the same data (just using a fixed record instead of individual parms)
» Note also that you must fill in the input values in the array and click callRPGS3 to return the 4 ShipCosts

Call RPG Frograms From EGL

Fillin Shiptype(1-%), ShipOption(1-5) and ZpCode - and click callRPG1, ar click: calRP G2
Fill in the input fields in the array below, and click callRFG3

Shiptype: |1 |
ShipCption: |2 |
ZipCode:  |30210 |
ShipCost 420

| callRPG1 || calRPGZ || caIIF{PGENL
L

© 2009 IBM Corporation 130

Shiptype ShipOption ZipCode ShipCost
1 2 33333 5.00
Ship: |3 4 | [55555 | 3.50
4 BE EARER | 14.60
5 Bk 77777 | 16.50 ***Notes T=2



EGL and Services (SOA)

Topics:

= EGL and Services Overview
= Creating and Consuming Local Services

= Setting up for Web Services

= Creating and consuming an EGL Web Service
= Consuming a 3" Party Web Service
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The Promise of Services and SOA (Service Oriented Architecture)

Services are the driving business system design paradigm of the day.

Services — implemented in EGL provide a cross platform language for business oriented development

Services and SOA are based on the concept of “Service Oriented Design”

At development time...
= Focus on the business logic
= Implement SOA design elements: services and interfaces

= Leverage existing business developers for new SOA
development

= |gnore deployment targets/technology while coding/testing

Leverage external web services...
= EGL Interfaces
= Represent external web services
= Are created via import from WSDL

= Allow the EGL developer to stay within the
context of the EGL programming model

Deploy EGL services...

To any platform

= Java to WAS/Tomcat/etc.

= COBOL to CICS, iSeries

As...

= A Web service (uses SOAP)

= A private service (uses CICS ECI, J2C, or TCP)

= Other SOA runtimes when they reach critical mass

e

EGL SOA for WAS, CICS, System i consume external services

External
Web

Service

Service * Interface g

Records ,

\_

Service

A4

Deploy Services as Web Services WSDL

External Applications
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Service Oriented Design — Concepts

¢~ Service Orientated Design is a software design paradigm that encourages the
creation of functionally discrete (modular) business logic, composed of standardized
software components (logic routines and subroutines with standard interfaces)

= Services are software components that:
» Are logically separated, along the lines of a “business service” — such as:

= Rent a car — which is further de-composed into:
— Reserve a vehicle — consisting of lower-level services such as:
— Confirm a location
— Confirm the customer information
— Get payment information
— Confirm customer and payment information
— Create the reservation

= Services are formally declared with a standard network interface that allows them to
be invoked by other services that only know the interface.

= Also, services:

» May be created at various levels of business/technical granularity (i.e. low-level vs. high-
level)

» Can be assembled/combined (“choreographed”) to create higher-level business
functionality

» Can be deployed to any platform — independently — and called from any platform through
their network interface —_—=

——
-— -

- o—
—
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Network Interface (and More Services Concepts)

= “A Service is a network interface to programs that live on a particular machine
implemented in such a manner that any other program (or many programs) running

on any other machine, written in any language, and running on any OS can call it.”
Bob Cancilla, IBM.

=  Additionally:

» Services are an abstract design pattern - they are not the same as Web Services
In fact, a service can be implemented using a number of different technologies,
including:

= RPC (Remote Program Call) - which you implement with an EGL:
— Local Service ...or...
— Library call ...or...
— Program

= DCOM (Distributed Component Object Model)

= REST (Representational State Transfer)

= CORBA (Common Object Request Broker)

= Web Services — which you implement with an EGL Service part

= The “network interface” for a Web Service is formally termed a WSDL
» Web Services Description Language
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Creating and Consuming Services — WSDL Files and EGL Interfaces

= WSDL is an XML document used to describe and locate Web Services.

= AWSDL:
» Specifies the run-time location as a URL
» Specifies operations and data in the Web Service
» Is written in XML using the SOAP transport protocol

= But you don’t want to:
» Learn XML or SOAP or...
» Create the WSDL files manually ®

= You want to code EGL business logic — exactly as you've done all along in
this course ©

» So in fact, the RBD tooling will generate all of the “plumbing” for you — when
you create or consume Web Services:

» When you create an EGL service, the tooling generates WSDL files, so you will not need to
learn XML (and other low-level languages, terms and concepts)

» When you consume a service, RBD generates EGL Interfaces from existing WSDL files for
you — automatically
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EGL and Services

Overview

Sub-Topics:

EGL and Services Overview

Creating and Consuming Local Services
Setting up for Web Services

Creating and consuming an EGL Web Service
Consuming a 3" Party Web Service
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A Simple EGL Service

A service (Local or Web) is coded from the same basic EGL programming
model you've used all along:

» package statement

» import statement(s)

» service <UnigueName> {optional properties}

» Global data (area)

» Functions —including a returns (type) on the signature

package services; //What folder do I live in?

import eglderbyr?y.data.Customer; //Alccess EGL source in other folders

AT am a Service Part
service servicel SAMy unicgque part name is "servicel"”

ffiGlokhal data (availakhle to all functions in the Serwvice)
wsy string = " 4+ got to servicel.mwyServiceFunction!'™:

J4 Zervice Function Declarations
Sffunction <functionMames> (parameter list) return(type)
function nmylerviceFunction(parmin string) returns(int)
parmin = parwmin + mwsg;  Jibhusiness logic
return (0] : Sfreturn walue
end //function-end
end //service-end
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EGL Services — Steps for Creating and Consuming Local Services

¢~ Here are the high-level steps to create a Local Service.

= To create a local Service using EGL

Code the service

Generate the service

(if not available) — Create a new services descriptor file

Add the service as a local service

(if not done) Point to the services descriptor file, from the build-file
Generate the descriptor file

o0k wih=

= To consume a local service from an EGL client

1. Code a variable of <serviceName> type in the client logic

= Add a Bindservice property with the appropriate bindkey (not shown, and optional if
service binding name is the same as the service part name)

serviceVar servicel {@Bindservice{}};

2. Code the call to the ServiceVar.function(...) — passing parameters
retCode int = serviceVar.nyTest (zipIn);
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EGL Services — Conceptual View

& To do a Web Service as opposed to a Local Service, you may want to architect a
separate project for your Web Services. You can think of this as a “service” project —
and you can think of calls to the web services as coming from “client” projects

Client Project
* Client process | _.
e Service Variable | _ _.---77

e Call to the Web service*|
e Deployment Descriptor
* WSDL (copy)
o

s HGL Interface

Cotirnon

Note — in our example we will use the

same project, but as a best practice, you
might consider a separate Service Project
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EGL Services — Steps for Creating and Consuming Web Services

&~ Here are the steps we’ll take together, to create a new EGL Web project (from
scratch) and use it as our Web Service project.

1. Start Tomcat — or WebSphere (see ***Notes)
2. Customize your project’s Build File
3. Create and generate a Web Service
= Code the service
= Generate the service
4. Generate the WSDL for your Service — may need to customize the service port (end point)
5. Test the WSDL Using Web Services Explorer

6. Consume the Web Service
= (If using a 3 Party WSDL) Import or copy the WSDL to your Client/Project
= Add a WSDL entry in the services descriptor file for all Web Services
» Generate the services descriptor file
» Inthe client process - code a variable of <serviceName> type
— Add a Bindservice property with the appropriate bindkey
= Code the call to the ServiceVar.function — passing parameters

1. (From the Servers Tab) Start Tomcat (or WebSphere)
Properties | Cuick Edit m::unsule Tasks | Problems | EGL S0OL Errars | EGL Generation Results e o mER T8

Server Status Stake
[+ E Tomcat ¥5.5 Server with EGL debugging support @ localhosk E- Starked Synchronized
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M 2. Customize Your Project’s Build-File

= Next — you need to select the serverType you will be publishing the Web Server to

» Open EGLWeb.eglbld
» Un-check Show only specified options
» Scroll down to find the serverType option

» Use the combo-box to select the serverType for your project
) x

4] EGLWebWebBuildOptions

= WEBSPHERE
= TOMCAT

9 Select the serverType

= From Project Explorer:
» Generate your Project

Build opkion filker:

Load DB options using Connection: |

Al

General Options

w

] (o]

Show only specified options

Opkion

dbms
deploymentDes. ..
genDataTables
genPraoject
gerProperties
jZee

serverType
sqlIMDIMame
syskem

Yalue (F1 For Help)

DBz
EGLWeb
YES
EGL'Web
GLOEAL
YES
TOMCATS. X

WEESPHERES.
WEEBSPHERES. 1.2
CIC335.1

(no value sek

© 2009 IBM Corporation 141



Wl 3. Create a new EGL Web Service

= (If not already done) Create a new EGL package in your EGLServiceProject under
\EGLSource\ named: services

= Create a new Service, in the \services\ package named: ZipService

= H EGLServiceProject
‘& Deployment Descriptor: EGLServicePraject
G-L-. Security Editor
oy, Web Diagram
B 'web Site Mavigation
= [LI} EGLSource

42 ¢

2 95,2 = Copy Chrl+C
= web
=5 Eclweb 3¢ Delete Delete
A 0epl  Rename... Alt+Shift+R
B %ol mave.., Alk+Shift-+
ey, weh

3 web pxg Import...
¢ EGLY o Export...
T8 Jave
= bin | & | Refresh ]

™ Project...

4 Data Table

‘{@ Ceployment Descriptor
[ EGL Package

| & EGL Source File

i EL Source Folder

€& Interface

B Library

i Program

|ZI Check: Create as web service

\ 4

See ***Notes

Source Folder; | EGLweblEGLSource

Package: | services

EGL source file name: | FipService

| by

Implements Interfaces:

Create as web service

[Shu:uw Advanced ==
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M| 3. Create a new EGL Web Service - continued

= Create a new function in ZipService named: caTestbk

lEEMSEWE&Ed x

package servicesz;

sService Zip3

ervice

el=e

end

\\‘end

return(0) ;

return(-1) ;

//'functiun caTezthk(zipIn chari(S)) returnsiint{\\
if (zipIn »>= "20001" and =zipIn <="9&000" )

J

end

You can either try typing the above function in (using Content Assist), or you

can copy/paste in the code — found in the Notes section.

Save the Web service

W Press Ctrl/S to save and validate the Service
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Wl 4. Generate the WSDL for Your Web Service

» Generate the Web service - From Project Explorer
- Select EGLWeb
- Right-Click and select Generate

After successfully generating the WSDL, you can open it in the Content Area — it’s

located under: \WebContent \WEB-INF\wsdl\

= T O || 2@ zipservice.wsd B3

r. Project Explorer X Gallery — <}=r=l">

== WebContent
+-[== images
+-[ = META-IMNF
+-[== theme
=I-[== WEE-INF
+-[= lib
H = s
=== wsd|
¥ moviefunctions, wed|

¥| Faces-config.xml

E

i85 FipserviceService

Wigw: default =

'ﬂ' ZipService

= ZipService

http:fflocalhost: S0S0/EGL. . .

488 caTesthlk

Lxlinput

parameters [8] caTesthk

<11 output

parameters |e| caTesthkResponse

= Close ZipService.WSDL — unless you are using WebSphere ***Notes

s Next we will test the Web Service, then we will work in the Client Project and call
this Web Service from both a batch program and your updatecustomer2 web page.
But if you are using WebSphere — before continuing please read the Slide Notes —
as you may need to customize the WSDL “end-points” — the port# for the WSDL

address.

***Notes
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Ml 5. (Optional) Test the Web Service - Interactively

== webCaonkent #
& RBD offers a nifty interactive o
Web Services test facility called = theme
the Web Services Explorer. = 5 WEB-INF
= lib
. = ws
You can use this tool to test your == wsdl
Web Service functionality ] mowiefunctions.wsd
effectively, before embedding R oserice sl R
calls to it from your service client. L] Faces-config.xml
|¥] ibm-web-brd. xmi Open F3
.% ser;fer-l:ll:unfig.wsdd Open With ,
web,m
E allcustomers. jsp 1=| Copy Chrl4+C
From Project Explorer — find: ] slcustomersz.jsp
. . : [l allcustomersEditPanel js o Fast Chrlay
ZipService.wsdl you just 51 allorders. e ([ Paste r+
generated under Bl arkTestPagez.isp % Delete Delete
\WebContent\ WEB-INF\wsdI\ Bl calc.jsp Build Path ’
& converter jsp Refactor Ale+Shift+T #
. . @ csvRecPage.jsp ﬁglmpnrt...
M nght'C“Ck over [ danTestPage.jsp  Exoot
ZipService.wsd| o I
[l eqDataTypePage.sp & Refresh =3
[l eglDataTyptePage.jsp
] hellal.jsp EGL Services k
. El helloz.jsp validat
=  Select Web Services B hello3.isp :'laﬁ R
» Test with Web Services B jsfhandler1.jsp RE: :'1'5 .
Explorer & menu.jsp '
= mavieFage. jsp DEh'."g As
[l newaccount.jsp Profile As r
* k% . . ﬂ' reasonglobe. jpg Team *
Notes - please review if Bl someiterms.jop Compare With b
you do NOT see the Web Services < R“CE D T ———
. Web Services est with Web Services Explarer
Optlon shown here 0] Page Data 52 . Outline | Styles Linke | Iilibime b Publish WSDL file_ k

145 — —— w—  —
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Ml 5. Test the Web Service - Interactively

&> This opens the Web
Services Explorer —and
specifically, it opens your
ZipService in the
Navigator — and all of the
services functions are
exposed as Actions for
you to test.

» Click caTestbk
W Enter a zipCode:

w Click Go

»w Note that 90210
returns: 0

»w Less than 90000
returns: -1

*** Your Application
Server must be still
be started ***

Close the Explorer

Web Services Explorer

=0 Mavigator

Actions

£ WSDL Main
=22 file: /D ftesty7 Lworkspace 1/ EGLYWeb/EGLSG
=22 ZinServiceService

=8 ZipServiceBinding

S

@ Invoke a WSDL Dperation

Enter the parameters of this WSDL operation and dick Go to invoke.

—Endpoints

http:f flocalbost: B0S0/EGLWeh/services [ FipService

= caTesthk

Zipln =tring
Q0210

Go | Reset |

1 status

= rCaTesthkResponse
- Group 1
zipIn (string)
= Group 2
zipIn (string): 90210

return (int): ol
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Steps for Creating and Consuming Web Services — Client Project

&~ Review of the steps. By following the previous instructions you have created the
Service Project, Service and deployed it as a Web Service.

1.
2.
3.

4.
5.

6. Consume the Web Service

(If using a 3 Party WSDL...next workshop)

— Import or copy the WSDL to your Client/Project

— Add a WSDL entry in the services descriptor file for all Web Services
(If you've created an EGL Web Service...this workshop)

— Create an EGL Client Interface to the WSDL
= Generate the services descriptor file
= |n the client process - code a variable of <serviceName> type

— Add a Bindservice property with the appropriate bindkey

= Code the call to the ServiceVar.function — passing parameters

# Note — we are not using a 3@ Party WSDL in this workshop, so we begin
with the step to create an EGL Client Interface to the WSDL
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M| 6. Create an EGL Client Interface to the WSDL

(from Project Explorer)

= Right-click over ZipService.wsdl
= Select: EGL Services > Create EGL Client Interface...

=s-config. xml

-wieb-bnd . xmi
ver-config.wsdd
3,

mers,jsp

merss, jsp
mersEditPanel. i
5.jsp

Pagez.jsp

etjsp
lage.jsp
FPage.jsp
FPagez.jsp
1TypePage.jsp
1ITyptePage.jsp
sp

sp

sp

= Click Next >

M

Open
Open ith

= Copy

i Paste
¥ Delete
Build Path

Refactaor

£y Import...
= Export..,

£ | Refresh

EGL Services

Yalidate

Analssis

F3

Ctrl+C

el

Delete

Alt+shift+T

FS

-

Create EGL Service Skeleton, ..

Create E@L Client Interface. ..

v

& New EGL Part

New EGL Interface

(X)

Create EGL Interfaces from a WSDL file, and add web servicefs) client bindingis) to EGL deplavment descriptor file =

Select the interfaces from the web service you want to create;

Create Web Services Client Bindings
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M| 6. Create an EGL Client Interface to the WSDL

From New EGL Interface

= Rename the EGL source file name: IZipService
= Rename the Interface name: IZipService

& MNew EGL Part

New EGL Interface

Create EGL Interfaces From a WaOL File

See **Notes

Source Folder: | EGLwWeblEGLSource
& New EGL Part
Package: | SErvices . L
New EGL Web Client Binding
EGL source file name: | IZipService | &dd EGL web client bindings) from a WSOL file ko EGL deployment descriptar File =]
CE ZipService

Source Folder: | EGLwWeb\EaLSource

Interface Mame |IzipService |

Functions l;? caTesthk

Eal deployment descriptor File name: | “Glweb

Port: Interface Mame

Binding Mame
Eﬁ;ZipSnar\\fiu:E services, IZipService

IZipService

[Jupdate all existing bindings

u CIiCk NeXt and then FiniSh )] Mexk = Finish RJ [ Cancel

e
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Optional Workshop - Call the Web Service From a Web Page

¢~ Recall that you have an updatecustomer page that allows customers to update their state and
zip code. We can invoke the ZipService as a Web Service, and test for California/Zips

KIKIKIKT K1 KT KRR K

updatecustomer
JSP Page

T

App
Server

\4

updatecustomer JSFHandler
Edits done server/side locally

Invoke zipService <

o
App

Server
LI
Remote Process
» zipService.caTestbk(...)
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M| Create and Consume a Database Service

WebContent by right clicking
“WebContent” > New = Folder

i roject Explorer X I alery| = O
==

12 EGLSOA400
¥ EGLWEB400
E-1= Servers
#-[= Tomcat +5.5 Server with EGL debugain
=& soad00
@ Deployment Descriptor: S0A400
@ EGLSource
[# ‘ﬁ Java Resources
%oy, web Diagram
B Javascript Support
ﬁg Securiby Edikar
& web Site Mavigation
== WebConkent
(= META-INF
(= theme
(= WEEB-INF
[ 15R-109 Web Services

Create a new project: file > New >
Project

Name it SOA400
Create as an EGL Web Project
Create a folder name wsdl under

New EGL Project

Enter the name for the new project and select a project type i‘ !

SOA400 |

Project name:

EGL Projeck Types
(%) ‘Web Project
() General Project

An EGL-enabled Web application that contains \Web pages, Web services, or both

A project For general use, including EGL batch, legacy Text UI (3270/5250), reporting, Console UI,
and E&L Service applications

() Plug-in Project
() Rich UI Project

& rich clienk project that uses EGL code bo create a Windows or UNIX-based Fat client application

& project containing EGL Rich UI applications, custom widgets, or both

Folder

Create a new Folder resource,

Entet or select the parent folder:

| SoA400/wWebConkent

| < Back ” Tk =

Cancel

¥ EGLsoa400
=2 EGLWEBH0D
[#-I=F Servers
&2 508400
= .apt_generated
(= .settings
(= EdLbin
(= EGLSource
@ Src
[ WebContent

T
Falder name: | wsdl
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M| Create and Consume a Database Service

= Create a AS400 Web Service to access database records

Create a new service. If you do not have a service package set up, right
click EGLSource > New —-> Package and name it “Services”

Create a new service by Right click Service Package and >New - Service,
name it “CustSvc400”.

Check “Create as Web (SOAP) service check box. (Very Important)
Enter the code below: (you can use copy/paste and cirl-shift-O

& New EGL Service Part

New EGL Service Part

package services;

@ File already exists, ::
import iseriesddemosibmcom.StatusRec; Source folder: EGLWEB4D\EGLSource
import iseriesddemosibmcom.access.CustomerLib; Patkage: Seriices

import iseriesddemosibmcom.data.Customer;
EAL source file name: CustSved0n

/I service
service CustSvc400 Implements Interfaces:
/I Variable Declarations
status400 StatusRec; b .....................:
e . Create as Web (S0AP) service 5
/I Function Declarations i | Ocreste asweh (REST) service
function GetCustomer(searchRecord Customer inout, status400 StatusRec) 3 somivarsatood s s s nnant
CustomerLib.GetCustomer(searchRecord, status400);
end

function GetCustomerListAll(customerArray Customer[] out, status400 StatusRec);
CustomerLib.GetCustomerListAll(customerArray, status400);
end

end

i1
w
=1
=)
@
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M| Create and Consume a Database Service

= Generate your project by

focus on the project name,

right click and select
“Generate”

* Find the generated
CustSvc400.wsdl file in
WebContent/wsdl folder,
focus on it, right click and
select “Copy”

= Paste the wsdl into

= ES 50400
'&W Deployment Descripkor; SOA400
[,;I} EGLSource
8 Java Resources
ey Web Diagram

LLES =tmtimian pn g earna

== WebContent

= funct

[= META-IMF
= theme end
=-[= WEE-INF
= lib
(= wsdd
= wsd end
AP CustomerServi

= funct

Mew L4

i 1LISES Y CA00,

AP ZipService.wsc Open E3
Wi Faces-config,xml

Cpen With r

|| server-config.wesdy
@ web,xml
E allCustomer . jsp
E getCust3ervices.jsp | 9§ Delete Delete
T testwehService.jsp

B nindskarickamar dcn

MR TTTY L LR P R

Mave,.,
Fename... Fz

A serwvic
“'service C

SOA4O O/ B JavaScript Support /i Wa
ﬂ’g Security Editor statu
B web Site Mavigation
WebContent/wsdl folder B WebComon [ or
= META-INF - funct
= theme C
= WEE-INF end
= " R
(22 I5R-109 We =
=/ Copy Chrl4HC
K Delete Delete
e ===
193 ==="=.
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== SOA400

M| Create and Consume a Database Service

Create a client interface for the wsdl in the

new project

= Go to the new project SOA400, right click

on CustSvc400.wsdl

= Select > EGL Services - Create EGL

Client Interface
= Click “Next”

» Name both EGL Source

#-'z5 Deployment Desc

& b"" EGLSource
+- 2% Java Resources

%y, Weh Diagram

riptor: SOA4400

service

servi

#- B JavaScript Support

f@ Security Editor

& web Site Navigation

== WebContent
*-[ = META-INF
#-[== theme

+-[=- WEB-INF
== wesdl
+-[2 J5R-109 eb Service Mew
Open F3
Open With
=| Copy Chrl4+C
2| Paste Chrl+y
¥ Delete Delete
Move...
Renare. .. Fz
£2g Import...
< £ Export...
@P s ‘t‘E‘S EEO @5% Refresh F5

Mo data components Found.

& MNew EGL Part

rice Custived00
/4 Variable Decl
ssssss 400 3 usk
/¢ Function Decl
function GetCustomer |
Customerlib.GetC il
Tl
function GetCustomerL L
C merLib. Getl il
d

[
w
2
=]
T

File Name and Interface
name aS “ICUStSVC400” Source folder: SOA400|EGL Source
It is good practice to name the —— | i mee
web interface as “I” + the Web P———
SerV|Ce name. —— Interface M;ame TCustSvedan :
_ R T ¥, 2 andna
» Click Next
} C“Ck FI n ISh [¥l0vernrite existing files
» Generate the SOA400 =
Project —
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M| Create and Consume a Database Service

@ Create a Mew EGL Data Variable

Preswvigs
customerArray Customer[0] {maxSize=100};

Let’s consume the SOAP web
service you just created

| Datatreabefinition (com.ibm,eqlissries: maximum arra vy length
. @DataQueueDefinition (oomm.ibm, eal isetie o

» In SOA400 project, create a < >

new web page: e
= SOA400/WebContent - right

Cl IC k 9 N eW 9 We b P ag e You can add data contrals ko your page ko display the contents of an EGL element

. I . T Add contrals to display the EGL element on the Web page

= Name it “svcAllCust.jsp”, select

a template and click OK,
= Drag “New Variable” from Pallet | e o s ien | ——

to the page and select |

“C u Sto m e r” [ata conkrol ko create: | Mulki-Columin Data Table (one bable row per data entry) -
" M ake it an Array " Cl;;a[t)'i_as:;:tirnoglsa;ore:xisting record (read-only)
= Check “Display Existing O

R eCO rd ’ Columns to display:
= Click “None’ A
+ Select Customerld, FirstName, | ‘5= 25 22

LastName and Phone. phone (1) e cupiticd 8 @

. L [ all ] [ Eeintz ] [ 9ptians. .. | Configure Control Types
= Click Finish
[ Firish ] [ Cancel ?T;‘;f__‘-__f
— ==2=%%.

Type Selaction Recard Type

) Primitive Enter the name of the Recard part
() Dataitem
@ Recard <% | Customer {iseriesddemosibmeom.data/T

Array Properties
Array
Size

100|
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M| Create and Consume a Database Service

= Edit the Page Code

= Add the following lines of code

» USING CONTENT ASSIST! (please ©)

status400 StatusRec;

// Function Declarations
function onConstruction()

iICustSvc400 ICustSvc400 {@bindService};

customerArray = iCustSvc400.GetCustomerListAll(status400);
end

» Run the page
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M| Create and Consume a Database Service

» You just successfully created and consumed a database web

service in minutes.

» This would normally take a skilled SOA developer at least two

days to complete.

|__|%| ICustSyc400, eql svoAllCust.jsp Eé sycAlCust.eql 27 & Mo page to display

package jsfhandlers:

“import iseriesddetmosibincom. 3catuskec:
import iseriesddemosibmoom.data. *:
import com.ibm.egl.jsf.*;
import services. ICustiwvodOoo;

~handler =svchllCust type J3FHandler

= {onConstructionFunction = onConstruction,
onPrerenderFunction = onPrerender,
cancelonPageTransition=yves,
view = "swvcldllCust.jsp",
viewRootWVar = wiewRoot}

vwiewRoot UIViewRoot:
custaomerirray Customer[0] {mwax3ize=100};
status400 3tatusRec:

S4 Function Declarations
= function onConscructioni)
iCust3vedld ICust3vod0d {fhind3ervice};

customerlirray = iCustiwvod00. GetCustomerListlll] (status400) ;

end
= function onFrerender ()
end
end

@ Mo page

= = q)‘h |http:,l',l'lu:ucalhn:ust:BEIEl,l'SOMEID,I'sw:AIICust.Faces ﬁ

|__|%| ICustSycd00.egl el swoallCust.jsp |__|%| svallCust.egl

List of All Customers using VWeb Service

Customerld | Firstame | LastiName | Phone

1 Fred Filibuster (91916586-0909
2 Andy Lundguist  (21)545-5467

3 Diana Martin (203)878-8790
4 Francine  Liebowitz  (414)980-1360
o Ornette (Coleman (51811324279
6 Ellen Springsteen (7121469-5533
7 MAartin St Louis (B701250-5689
s Sergey Sharoy (4131452-1983
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Optional Topic - Consuming a 3 Party Web Service

¢~ EGL/RBD also allows you to call external (3@ Party-Provided) Web Services. If time
remains in your lab, try the following short workshop to see for yourself!

Here are the steps you follow (from 10,000 feet):

Using a 3'9 Party WSDL Steps:
1. Identify/Locate the WSDL file from which the interface will be created

2. Download this WSDL to your project
3. Create an EGL Client Interface

4. Create a calling (client) JSFHandler page

It’s really that easy! But a note of caution first:

» This next lab requires that you be running a live connection to the internet — free
I and clear of any corporate fire-walls, or it most likely will not execute.
: (See ***Notes) Not withstanding, if you will be using 3@ Party services it’s
= probably worth understanding the work-flow steps to implement with EGL.

running when you test it — as this is not under our control.
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» Consuming a 3" Party Web Service - Find the Service

. Address btk v, xmethods, net)

1. Identify the WSDL

flle from WhICh METHO DS Home - Tools - Iimplementations - Manage - Begister
the interface will - Tutorials - About
be created _— and WSDL Web Services Free SOA Testing Book Oneway Services..your way

. Rapidly develop SOA-based buzines: 40 page, step-by-step guide to irmproving Full Sarvice 2rd party ELI provider
download thIS saolutions, Get the Free Whitepaper SOA tasting and quality w 24/7 data access via web

wuw, SkowauSoftware, com www,rmnindreef. com/book W, ONewWwaysertices, com

WSDL to your
project

CDYNE®se: 7 R
=i Eetter g

FPostal Address Verfication Web Service

=N VALIDATE YOUR WEB USERS IN REAL -TIME.
# Mame & Email .q'

& Address & 1P S,Eﬁ,ri.ceﬂbjects .';t
g Phﬂﬂe MNSIGHT O DEMARND:

Welcome to Xhethods.

Ml From the Emerging web services standards such as 30AF WEDL and UDDI will enahble
= gyatemm-to-gystem integration that is easier than ever before. This site lists puhlich
Xmethods.net site ’ 7 & prbiey

available web services.
» Click:
View the FULL LIST

Recent Listingfs [ View the FUL@IST]

Publisher ite [Mame Description
This webzetrvic
YOORIPRONG Doz Tryplt [SBNTest vahidate an 10 ¢
numbet
Checkaum ElfF4
VOORIPRONG Do Trw It ElevenTest Eank Account
aatidren RPC Ty It Jalted SHA Hash Generator iafl?ip Seric
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» Consuming a 3" Party Web Service — Select the WSDL

» From the Xmethods site full list, then scroll (or Ctrl/F find) the
Ignyte Retrieve Theaters and Movie Showtimes service

Ionvyte's Retrieve Theaters atd IGEGT

Shoatithes

AL to TRL

Digital Sionature Setvice

Digital Sionature ¥erify

agl.coth

Zip Codes

Find what: |k ovie

[ ] Match whale wnr%anly

[ Match Case

Dhirection

{2 Up (&) Down

CGiven a zip code and radius, this will return a lis
theaters and movies currently playing.

MW Click the link for the Web Service you wish to copy from the Xmethods site:

Ionvyte's Retrieve Theaters atd I

. Civen a zip code and radius, this will return a list of

Sho B3

TIRAT 4 TTTAT

theaters and movies currently playing.

Gend a piece of ZMWL and the service will return a TRI
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» Consuming a 3" Party Web Service — Save the WSDL

» Save the WSDL to your project’s \WebContent\WEB-INF\wsdI\

folder as: moviefunctions.wsdl (note you will need to rename the extension in the
project and probably Refresh (F35) the project directory you save into)

x M ETHODS Home - Intetfaces - Tools - Implementations - Manage - Eegis
T 1 1 T o W / .". J T -
Ignyvte's Retrieve Theaters and Movie Showtimes
Try It
WisDL httpe e donte. comiweb s erricesfionrte whats showing webs etvi
EPC Profili Open
SOAP Binding Mavielnfa Cpen in Mew \indow
Eey uuid:CBOE.  Prink Target % DéD1
Fim Project Explorer X Gallery =] <,}==§> 7
(= build
== WehContent
[= images
= META-INF
[-= theme
== WEE-IMF
| = lb
= ws
File name: |m-:| efunctions. wedl == wsdl
i [ LAl rroviefunctions, wsd|
Save as ype: AllFil > =y
b | 1es L}& |X| ZipService, wsdl ————
|X| Faces-config. xml = == ===
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» Consuming a 3" Party Web Service — Create the EGL Interface

S wsdl |
. . . . noviefunckions, wsdl
W Right click over moviefunctions.wsdl — select: ) eervice ved N b
|X| Faces-config.xml Open F3
- EGL Services > Create EGL Client Interface... [ ™= Open With b
@ web.xml | Copy Chrl+C
- Click Next > two times 2 akcustoners fp
% a::CL'sE”mE”E'jj_iE y % Paste Chrl+v
2| allcustomerseditFanel, jsp
5 alorders. isp ¥ Delete Celete
Build Path 4

. . . & arkTestPagez.jsp
From New EGL Web Client Binding 5 calc s Refactor Alyshift+T ¥

B converker ., jsp

. L £y Import. ..
- Clle FlnlSh & csvRecPage.jsp P
. g Expart,.,
2] danTestPage.jsp
# | Refresh FS
& New EGL Part X =
EGL Services Create EGL Service Skeleton. ..
New EGL Web Client Binding " Create EGL Client Interface. .,
' Validate
Add EGL web client binding(s) From a WSOL file to EGL deployment descriptor File = L .
Source folder; | EGLWeblEGLIource | [ Browse, ., ]
EGL deplovment descriptar file name: | EGLwWeb | [ Browse, ., ]
Paort Interface Name Binding Mame P
s MovieInformationSoap com. igrvke e, whatsshowing, MovieInfa, ., MovieInformationSoap -
¢ T H

[ JUpdate all existing bindings

':?:' Mexk = [ Finisht [ Cancel
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» Consuming a 3" Party Web Service — The EGL Interface

&~ This will create an EGL Interface to the 3" Party Web Service — that you can now reference in
(call from) client business logic.

| = maviefunctions,.egl X

package com.ighyte.www.whatsshowing:

record Theater{}
MName string?:
hddress string?;
Hovies Movie?[]:
end

record Movie{}
Rating string?:
MNamwme string?:
BunningTime string?:
ShowTimes string?;
end

record TpcomingMovied}
HovieNaune string?;
end

interface MovielInformation3oap{flxml {name="MovielnformationZoap®™, namespace="http

function GetUpcomingMovies (month int in, year int in) returns (TpcomingMovie?[]
function GetTheatersindlovies(zipCode string? in, radius int in) returns (Theat

But first we need to generate all the new Java Classes for all these new project resources

»w (From Project Explorer) Generate your project - note that you may receive Java
Generation errors, which will clean themselves up when you create the page (next part of lab)
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» Consuming a 3" Party Web Service — Create a New Web Page

P (From the \WebContent\ folder) Create a new Web Page named: moviePage.jsp

WebConkent

= META-IN

2= theme =] Copy ChrHC |_|<> File
&= wes-nF| B Copy Qualified Name [ Folder
[ _A_gray| [ Paste Chrl+y N

| »7 HTML
[] _B_blue. ¥ Delste Delets 2]

B - 15F
g BOLBI g path | 7
DALY pafackor Alt+ShIFE+T P

[ a_gray. -

& allcustom jug Import. .. @ web Page kSmplate

© New Web Page E

Web Page

Select a name, location, and template for a new web page, < >

File Namey | maoviePage. jsp |

Folder: | [EGLWeb " ebConkent | [Brnwse... ]
Template: Presview: Change the default
== Basic Templates
----- HTMLJXHTML - a——
..... @ 15p it 7 20 O IR Nata B *moviePage.jsp X

----- @ J=P Fragment
== My Templates

..... theme/B-01_blue. htpl .
----- theme/B-01_blue_.htpl

----- themne/E_blue. hipl
..... [# &_gray__

moviePage.jsp - &_gray *

| et's Go To The Movies,
----- @ & _gray_ I
..... [# &_gray
- [= sample Templates A_gray.htpl

£
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» Consuming a 3" Party Web Service - Edit the JSFHandler Code

W Edit the Page Code package )athandlers;
(mO\"ePage-egl) and import com.ibm.egl.jst.*;
using Content Assist import com.ignyte.www.whatsshowing. MovieInformationSoap:
create the fo”owing import com.ignyte.www.whatsshowing. Theater:

JSFHandler logic

handler moviePage type J3FHandler
{onConstructionFunction = onconstruction,

. onPrerenderFunction = onPrerender,
Note — please either use view = "moviePage.jsp",
Content ASSISt to wviewRootVar = viewRoot}
Create th|S |Og|C, or wviewRoot UIViewRoot:
COpy/paSte the theaters Theater?[0] : ffarray of Theater records
Completed Code from zipCode string: Sfwhere do yvou live?
the NO’[GS SeCtion Of th|S radius int:; Adhow far do wou want to drive?
Sllde /¢ Function Declarations
function onConstructioni()
end

function findMovies()
movieInformation3oap MovieInformation3oap {fhindService}:

theaters = mwovielnformationsoap.GetTheatersindlovies(zipCode, radius)
end

function onPrerender ()

w Press Ctrl/S -

and clean up any typos
or syntax errors ©
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» Consuming a 3" Party Web Service - Edit the JSFHandler Code

From Page Designer %Pruject Explorer X" Gallery | = <.1£_':> T *maoviePage.jsp oa DﬁmpviePagé
i % E;':Ei::gs - moviePade . jsp - A_gray *
W Press Ctrl/S — to refresh/synchronize - D servce Impl e .
: m zipService_Impl.java
the tOO|S : = -Ea- WG, SR

2o ot or e seoceed et [T
m R controls for the selected data

B wsdl : , :
- o5 _ #| et's Go To The Movies!l,
|X| eghweb Drop here to insert new
[X] maovisfu contrals for "findMovies" o

OdyssevBrowserFramework, properties

F P D : rununit, properties é] 5,- s

rom age ata : |X] servicesdescriptar 1-bnd, xmil :J

>>| HOId dOWh the Ctrl key, and Se|eC'[Z E'.;.lcll_ibraries + ZipCode - string
radius - int == WebConkent =

= images FindMoviesi )

zipCode - string s

findMovies ()

» Drag and drop them onto the page

w
Bl FageData X Outling | Styles /Thdmbeails | — O |
=

E| ‘{51}_{5

= Scripting Yariables
[=-[= 15F Handler

» Make the fields Input fields | b
® Updating an existing record | @5 theaters- 7
5%, viewRogy - UlvieyfRoot
: ﬁu zZipCode - string
W Delete any extraneous Submit Buttons =2 Actions ]

’:' FimdMavies)

created -
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» Consuming a 3" Party Web Service - Edit the JSFHandler Code

From Page Data

44

4
4

4

44

44

Select:
theaters - Theater|]

Drag and drop the array onto the page

Make all columns read-only
®Displaying an existing record

Click the ellipsis next to Multi-Column
Data

Make the nested columns read-only
®@Displaying an existing record

Click Finish twice

OPTIONAL

4

With the table selected, feel free to
change display properties:

» Outer table:

» Border: 1
Inner table:

» From Display options: delete
columnClassi

44

e
2 Insert Lis antro

Configure Data Controls

Specify the columns ko display and how to display them

[
Jesign | Source | Preview

'roperties | *Cuick Edit | Servers | 5 Cans
vebSphere Application Server va.1 [Websp

'5/12/07 9:53:25:296 EDT] (
'5/12/07 9:53:25:406 EDT] 0
'5/12/07 9:53:25:421 EDT] (g
‘5/12/07 9:53:25:437 EDT] (O
'5/12/07 9:53:25:515 EDT] (
'5/12/07 9:53:25:60% EDT] (g
'5/12/07 9:53:25:687 EDT] O
'§/12/07 9:53:25:781 EDT] (O
'5/12/07 9:53:25:796 EDT] (
'5/12/07 9:53:25:736 EDT] 0
'5/12/07 9:53:25:796 EDT] (O
'8/12/07 9:53:25:796 EDT] (O
'5/12/07 9:53:25:812 EDT] (g

© 2009 IBM Corporation

'[—5-—-i,-—i
Data contral ko create: | Multi-Column Data Table {(one table row per data entry) w |
Ciaabaconteole Fop:
(%) Displaying an existing record (read-only)
i Updating an existing record
OCreating anew record
Columns ko display:
Column Name Label Control Tvpe

Marme (string) Marne Qukput Field hd

Address {string) Address Cubput Field -

Movies (Movie[T) Movies ulti-Column Data ]

@ Insert List Control

Configure Data Controls

Specify the columns ko display and how ta display them

Cro b mbrole Fou,

() Displaying an existing record (read-only)
t Snpaaflng an EXISEII‘IQ I’ECDI’E

OCreating a new record

Columns ko display:

==

e Standard ~

tpliput

Column Mame Label Control Type
Raating {string) Rating CQubput figld ™
Marne (skring) Name Cutput figld ]
RunningTime (skring) RunningTime Cutput field =
ShowTimes (string) ShowTimes CQubput Figld >

':':’:' Finish ] [ Cancel




» Consuming a 39 Party Web Service — Edit the JSFHandler Code

» Run the page

W Enter a valid U.S. Postal Code
(ZipCode: 90210, 54903, etc),
and enter an integer number
(Radius) which represents how
far - in miles, you would be
willing to travel to go to the
movies.

é"Note that you must have a
live, free and clear internet
connection (sans Firewall) for
this page to work.

G0 El

Let's Go To The Movies

http: fflocalhost: 9081 JEGLWeb/moviePage . Faces

ZipCode: |27587

Radius; 10

findMDvieE
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MName Address Movies
Rating | Mame RunningTime | ShowTimes
28 Weeks . 12:00pm | 2:25pm | 4:50pm | 7:25pm |
R Later Thr 40 mins 9:50pm
Are Wie 3 : . .
FG Done Yet? Thr3Z2mins  12:20pm | 2:30pm | 4:40pm
Blades of . 12:05pm | 2:25pm | 4:45pm | 7:05pm |
FG-13 Glory 1 hr 33 mins 9 15pm
PG-13 DeltaFarce 1hr30mins ,=40PM|2:50pm|5:10pm | 7:30pm|
9:35pm
PG-13 Disturbia 1 hr45 mins %aggm|2:40pm|5:05pm|?z35pm|
10600 Fracture Thr53mins  650pm| 9:25pm
Marquee Zommaon G .
Wakefield 12 | Oaks Drive, | R SOrdIa 9 hr53mins  110pm | 4:10pm | 7-10pm | 9:45pm
Raleigh, NC Rule
FE-13 LuckyYou  2hrs 04 mins 12:45pm | 9:30pm
Meet the ; ) . . .
e RobinEoMs Thr3d mins  171:45am | 2:05pm | 4:30pm | 6:55pm
FGE-13 Mext 1Thr36mins  920pm
11:20am | 12:15pm | 1:00pm |
Spider-Man o 230pm | 315pm | 4:00pm | 5:30pm |
PC-13 4 2hrs 19 mMins 54 50m | 7:00pm | 2:30pm | 915pm |
10:00pm
PG-13 The Invisible 1 hr 42 mins ;.zéggfnm'2325pm|4350pm|73209m|

PG-13 Wild Hogs
Rating | Mame

EaTo R N ey oy

Thr39mins  345pm | 7. 10pm
EunningTime | ShowTimes

AT e | T D e | B A e | T |



» OPTIONAL - Call Google Maps using the Cinema’s Address — 1 of 2

s~What if you wanted to allow users to click on a cinema address, and have that bring up a
GOOGLEMAP of that address? Here are the steps (note that you may need help from your

|nStrUCt0r on th|S) theaters = mwovielnformationfoap.GetTheatersindMovies (zipfode, radius):;
end

» Copy/paste the code in this slide’s

NOteS, as a new funCtion: function getiddressHapFunci()
tableExl UlDhatar
}N CtrI/S —_— Save your Code tabhleExl = wiewRoot.findComponent ("forml:takhleEx1™)
row int = tableExl.getRowIndexi()] +1:
googlecity string = theaters[row] . Address;
gite string = "http://www.google.com/maps?hl=enstab=wlig="+googleCity;
forward to url =site;
end

» From Page Designer
» From the Palette/Enhanced Faces Components — find: Link - Command [ Link - Cammard

#" If it's not on the Palette you will have to Customize the Palette in order to show this option. Please ask
your instructor for assistance on this — or, from the EGL-JSF.PPT, read the slides starting with the slide
titled: Customizing the Palette

» Assuming you have the Link-Command in your Palene

»w Select the Address field in the dataTable’|##/Address)™
» Double-Click the Link Command
» From Properties click the All Attributes icon Al Attributes l

| R

» From action, click the Browse icon and select: getAddressMapFunc()

Cuick Edit | Servers | Console | Problems | EGL Generation Resulks |E|'{

b Attribuke Mame Value G

’ accesskey R specifies the value returned when the component
: » action #{moviePage. getAddress v | clicked. The value is passed to the default

Epl: put [ — [P mmn;;.;,--&' MavigationHandler, which matches the value again

169 ===
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» OPTIONAL - Call Google Maps using the Cinema’s Address - 2 of 2

» Run the page. Find movies and click an Address

Let's Go To The Movies

ZipCode: |27587 |
Radius. |10 |

Name Address Movies

|Raﬁng|Name |Runni‘ Web |mages “ideo MNews Maps Gmail more =

R é?ﬁé;ﬁiﬁ %m’ss l e.q., "0 market =t, =an francizca” or "hotelz near lax"
1 hr 5 8 e |1DEDD Cammon Oaks Drive, Raleigh, MC | [ Search Maps J
Map;

PG August Rush mins _| Search the map | Find businesses  Get directions

Search Results | | My Maps |
PG Bee Movie 1r = —| || el

; IE]
mins | & 10600 Common ks Dr [1] 3 |
Raleigh, NC 27614 IHI W | |
PG-13 Dan in Real Life r%nm’s,: Make this my default location ‘;d' | Address:
WF'f NeseRY | 0 Gommon Oaks Dr
1 hr4

Raleigh, NC 27514
Harques égﬁgu Counon PG Enchanted mins [

Wakefield 12 Ve

Raleidi, WG 1 hrE : Get directions: To here - From here
= Fred Claus mins | Search nearby - Sawe to My Maps
Edit He
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Summary

« EGL and RDi-SOA
 Easy transition for RPG and COBOL developers
« Best Web 2.0 tooling on the market today
« Evolve RPG and COBOL assets into Web Applications
« Ul Enrichment opportunities abound
e Low risk, Quick ROI
» Flexible deployment targets
 Highly productive and flexible language and environment

» Migrate at your own rate and pace: interactive programs only, complete
applications, or entire systems

* Next Steps
» Run a pilot
« Contact Your IBM Reps
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IBM EGL useful links

» Rational Developer for i for SOA Construction

» http://www-01.ibm.com/software/awdtools/developer/rdisoa/

» RDi SOA — Trails and Installation

» http://www-949.ibm.com/software/rational/cafe/docs/DOC-3128

» History of EGL

» http://www-949.ibm.com/software/rational/cafe/docs/DOC-3161

» EGL Trial Download

» http://www-949.ibm.com/software/rational/cafe/docs/DOC-1384

» RBD (Rational Business Developer)

» http://www.ibm.com/developerworks/rational/products/rbde/
» http://www-142.ibm.com/software/products/tw/zh/busdeveloper
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